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Proposal for a Linux book for the 
"Missing Manual Series"  
 

KDE as the Linux desktop and mix in a little gnome 

In July 2002, members of a European company contacted me to discuss a new 

project commissioned by BSI, Germany’s Federal Agency of IT Security. Three 

companies had jointly bid and won the contract to build BSI’s groupware solution. 

Their mission focused on replacing Microsoft Outlook and Exchange.  

One of the requirements of the contract specified the use of Open Source 

software. My team had already developed an Open Source groupware server on 

Linux. We also developed an Outlook client extension allowing us to replace 

Exchange. BSI’s contractors wanted to consult with us about their project. 

The German project became known as Kroupware and eventually kolab. The 

contractors knew of our software components and wanted to work with us. We 

eventually concluded that a modified version of Kmail from KDE would best serve 

the needs of their project.  

During the series of discussions we conducted, I became aware of indirect 

funding for the KDE desktop project provided by the German government. Over 

the next three months, I began to see an immediate impact and resurgence of 

Linux on the desktop. The progress and momentum continued until KDE looked 

like the dominant interface for Linux.  

I kept an eye on Linux distributions looking for news of desktop developments 

while discussing joint ventures opportunities with several Linux distributions. By 

late fall of 2002, several new distributions based on KDE made their debut. The 

new distributions included LindowsOS, Lycoris DesktopLX and Xandros.  
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Red Hat and SuSE even joined in with new desktops.  Red Hat billed their Linux 

personal edition as the best option for home computing. SuSE announced the 

coming release of their new Enterprise Desktop. 

The German government began Kroupware as an open-source initiative focused on 

Messaging and Collaboration. KDE made significant gains from the Government 

funding. KDE also benefited from the addition of program management and quality 

control. The three companies involved in the Kroupware project are:  

 Erlewein, Frank, Konold & Partner  (Concept, Server Implementation) 

 Intevation (Project Coordination)  

 Klarälvdalens Datakonsult (Client Implementation)  

KDE technology gave the Kroupware project a head start. Linux and other 

commercial UNIX variants had made KDE their default desktop.  Even Apple 

Computer chose KDE to build the Safari web browser. Safari bases its rendering engine 

on KHTML, the heart of the KDE Konqueror web browser. 

Adding management to the KDE project provided: 

1. A defined roadmap 

2. More efficient production 

3. More traditional quality control without thwarting creativity and participation 

4. Requirements control 

5. Specifications and project documentation 

6. Control over deadlines 

7. Organization of change management 

8. A coherent feature list 

9. Intelligence regarding the competitive landscape 

KDE gained significant momentum as a result of the above events and began to 

out distance competing Linux Desktop projects. 
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What to do with gnome 

The gnome project began approximately the same time as KDE. Linux advocates saw 

great promise in gnome. Most people thought that gnome would become the dominant 

Linux desktop. Red Hat supported gnome and presented it as their default desktop. 

 

Over time, the leaders of the gnome project founded a commercial company and gnome 

lost its momentum. KDE continued to make strides and soon became the primary Linux 

desktop. With the Kroupware project providing the KDE developers with resources, the 

future of gnome seemed dire. 

 

In February 2003, gnome maintainers approached the KDE team with a plan to have the 

two desktops closely cooperate. As discussions progressed, the FreeDesktop.org brokered 

an agreement between the Gnome Usability Project and the KDE Usability Project to 

publish joint Human Interface Guides. The announcement broke on the kde-usability 

mailing list.  In the announcement the following information appeared:  

 

“The easier we can make it for developers to discover and follow such guidelines the 

better it will be for Open Source desktops in general. Since KDE apps are often run on 

GNOME and vice versa, developers should be able to easily reference the guidelines for 

all the desktops they expect their app to be run on. 

 

“Having a shared document will also allow us to start looking at commonalities between 

the documents and perhaps create common chapters or sections on basic guidelines and 

lessons that are desktop and toolkit-independent (e.g., accessibility and 

internationalization tips, general usability principles).” – 01Feb2003. 

 

Red Hat changed its default desktop to Blue Curve in November 2002. Analysts felt that 

the change would influence gnome to pursue new options. Blue Curve combined the 

look, feel and usability of KDE and only added selected applications from the gnome 

project. Prior to the release of 8.0, Red Hat portrayed gnome as their default desktop. In 

fact, IBM Global Services Linux Portfolio Manager influenced Red Hat to build a unified 

desktop leaving out WINE. A patch in Red Hat 8.0 finally disabled WINE support.   

 

After the IBM specifications surfaced in the form of the Blue Curve desktop, Sun 

Microsystems and Oracle Corporation abandoned their Linux distributions and 

announced their decision to use Red Hat. 

 

With the release of Red Hat 9.0, the Blue Curve Desktop ceased including gnome 

applications where duplication of functionality existed. While Red Hat phases out gnome 

and KDE as separate options in favor of Blue Curve, gnome’s best chance at survival 

means merging. 

 

AUDIENCE AND PURPOSE 

I wrote this book proposal with the mission of benefiting fans or former fans of Microsoft 

Windows and Macintosh who wish to add Linux to their computers. The pull to bring 
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Linux out of the data center and onto the desktop has left a vacancy for a user manual. 

One might argue that publishers have saturated the Linux book market so that another 

Linux book seems dumb. When you look for a Linux manual for your wife, husband, 

parents, grandparents or children, you will instantly understand the need for this book. 

Publishers have not targeted the desktop audience.  

We will also find that readers at various levels of the technical scale need a desktop 

manual. Many of the gurus in the Linux developer community have not used the modern 

Linux desktop. Some people I regularly use for technical advice ask me to explain how to 

use parts of their desktop.  

Much of the advice I give involves setting up the Mozilla Browser, mail and installing 

OpenOffice. Sometimes I feel surprised at questions asked then realize early Linux 

professionals have always used the Command Line Interface (CLI). Now, they  can view 

web sites using the HTML 4.01 and XHTML.  

While a partner with IBM, I began discovering large deployments and migrations to 

Linux in the enterprise space. Companies like McDonnell Douglas, Merrill Lynch, 

Disney and Hilton Inns have migrated of thousands of users to Linux. IBM Global 

Services began offering Linux migrations at the request of their customers in 2002. IBM 

noticed increased interest in desktop Linux after the release of OpenOffice 1.0 and 

StarOffice-6.0, which IGS supports, maintains and services. 

Default Linux distributions provide users with a familiar look, feel and features of 

Microsoft Windows.  Unfortunately, the same kinds of problems found by Mac OS X 

converts plague Linux.  To find your way around, you're left with clumsy on-line help 

pages lacking context sensitivity.  The help pages require extensive topic searches, lack 

place markers and use unfamiliar terminology often without providing a glossary. In 

many cases, scant documentation exists for a number of bundled desktop applications. 

Tools 

If accepted, I will submit my manuscript in Microsoft Word tagged according to 

O'Reilly's paragraph and character style template which I found on your website. I am an 

experienced author. I understand book-publishing practices. I have worked with paper 

manuscripts and electronic source files that have paragraph and inline style tags. My first 

experience with markup tools occurred using IBM’s Bookmaster Document Composition 

Facility. I worked on a documentation team, which produced manuals for OS/2 Warp and 

AIX. 

I have used many other publishing tools. The most significant of those include 

FrameMaker, Adobe PageMaker and Adobe Acrobat.  

I have a history of significant productivity as a writer. I surprise editors with my speed of 

completion. Knowing the importance of "time to market" with this book series, I believe 

you will appreciate my work ethic and creativity. 
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ABOUT THE (Prospective) AUTHOR  

I began a serious writing career in 1985 with the publication of my first trade book 

published by Longman Financial. I wrote continuously under contract from 1984 until 

1992 for the Texas Society of CPAs and the University of North Texas Professional 

Development Institute while working full time as a senior executive of a busy NASD 

brokerage firm.  

In 2000, Sams Publications included me as a co-author of two of their Linux 

Administration Unleashed series. I also wrote the underlying draft for an internal IBM 

Redbook called "Installing and Administering Bynari Insight Server". For the last four 

years, I have written a number of on-line and print publications, the most recent of which 

appeared in the February edition of "Linux Journal". 

Recently, I received some notoriety for starting a company, breaking the code on 

Microsoft Exchange and replacing it with Linux. I sold the first enterprise application for 

Linux on the IBM S/390 to Winnebago Industries. As a result, IBM approached the 

company I founded and we became the first IBM Linux Influencer Partner. I became a 

celebrity within IBM as a result.  

My background in Information Systems includes roles as a programmer, project manager, 

system administrator, executive and inventor. I specialized as a CPA in computer 

consulting and wrote the first commercially successful microprocessor based 

comprehensive accounting system early in my career.  

Finally, I confess to spending my youth as a musician and songwriter. I attained some 

limited prominence for writing the scores to an album, which won Best R&B 

Instrumental and for my agility as a studio musician. 

Inspiration for this Project 

My inspiration for wanting to write a "Missing Manual" came from a personal event. The 

winter before discovering my wife had meningioma; we bought a Mac G4 Cube for her 

Christmas present. Six months later, she had a mass extracted from her brain and soon 

began rehabilitation. At some point in her rehabilitation she wanted to use her Mac.  

I became frustrated trying to find a book to help her.  While searching, I came across Mac 

OS 9:The Missing Manual hidden from view in the wrong section of a computer 

bookstore. I felt like a child finding candy.  That book became most valuable in helping 

my wife recover and I will always appreciate it.  

To complete this story, I started using Linux regularly in 1998. I became deeply involved 

with Linux initiatives as a consultant and later as the founder of Bynari.  At LinuxWorld 

2000 in New York, Bynari released the first Linux/UNIX client, which could operate as a 

peer in a Microsoft Exchange network. In designing and bringing this product to market, 

I gained extensive knowledge of Linux desktops and server applications. 

After leaving Bynari, Xandros retained me to build a Linux workgroup server designed 
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specifically for their Linux desktop. Using Xandros Linux as the baseline for the server, I 

gained invaluable hands-on knowledge of their Desktop Linux. With recent knowledge of 

several Fortune 500 Linux desktop rollouts, I published an article in Consulting Times 

entitled “Desktop Linux Threatening Windows”.  

  

Outline and Proposed Chapters 

 The proposed manuscript covers areas, which include: 

 Linux’s Human Interface 

 Configuring Linux  

 Networking, the Internet and communications  

 Applications, programs and processes 

 Technologies  

 Linux Resources 

 Appendices 

Preface Note: Given the style and content of the "Missing Manual" series, each item 

below will have a significant number of screen shots, graphics, sidebars, tips and act ion 

paths in the manuscript. Knowing this, I wrote the outline sans graphics and sidebars. I 

plan to provide all necessary graphics using a variety of tools including Photoshop and a 

set of screen capture programs written for Linux. I will provide sidebars, tips and insights 

as appropriate. 

 

Introduction to the Outline 

 

I expect the reader of a book from the Missing Manual series has investigated, decided to 

purchase or already owns Linux. He or she may have wanted to buy Linux and install it 

on his or her own accord. Perhaps compliance played some part in the decision making 

process of the reader. Whatever prompted the reader to move in the direction of Linux, I 

feel comfortable introducing it as a modern personal computer system.  

Linux has a reputation: It works and plays well with others. Early in the introduction, we 

can clear up misconceptions about Linux without dragging the reader through the OS 

wars.  
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The reader will find the "About this Book" section useful in becoming familiar with 

conventions of the manual.  He or she will also find a roadmap of what to expect from the 

materials including the concept of "what's it for". I did not include an outline of “About 

this Book” with this outline. 

RedHat's Blue Curve Desktop exemplifies the unified Linux desktop initiative. Blue 

Curve started with the release of RedHat 8.0. Now, RedHat 9.0 provides evidence that the 

concept of RedHat’s unified desktop works for other distributions of Linux. 

Analysts believe that KDE owns approximately 75% of the Linux desktop market. 

Starting with version 6.0, RedHat promoted gnome as their default desktop. With Blue 

Curve, the desktop actually leans heavily on KDE while incorporating important aspects 

of gnome into Blue Curve. 

Prior to the release of RedHat 9.0, I upgraded a working distribution of RedHat 8.0 to 

KDE 3.1. The upgrade of KDE blended with gnome in the manner which RedHat 

engineered their desktop.  My testing of the other major distributions clearly puts KDE in 

the dominant position as the Linux desktop of choice. 

I plan to provide compelling reasons for using Linux as the reader's primary personal 

computer. KDE, rpm and the Linux kernel have created a stunning technical achievement 

in computer desktop operating systems. Beginning with the modern distribution, I plan to 

weave the Linux advanced features in each segment depicting stability, flexibility and a 

dominant application base. 

 

 The Linux OS Desktop 

 

The desktop of a personal computer provides the main workspace, the space on which 

you open windows for running applications, icons for starting programs, and folders for 

documents and digital content. The reader will discover that Linux has a similar look, feel 

and behavior to Microsoft Windows.  This provides an advantage for those migrating to 

Linux. 

What the Reader Sees: 

The reader will initially see a main menu icon and a panel closely resembling Windows 

98 with a theme. The main menu icon opens a vertical menu that leads to launchers and 

submenus for individual applications and applets much like they do in Windows. Some of 

the first things readers will notice include: 

Kmenu icon, which reminds one of the “Start” button in Windows on the lower left of the 

screen. When the user clicks the familiar icon, the menu will launch with programs, 

control panels, services, games, programs, command line, etc. 
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The user will also see a panel bar similar to Windows with animated icons and resizing 

capabilities of the Mac OS X Dock. The user can turn the panel into a Dock by using 

Kmenu-> Preferences ->Configure Panel. The user will see a graphical panel, which he 

or she can use to configure the panel to take on the look and feel of the OS X Dock. 

The user gets a quick look at what's running and available without having to search 

through the menu by looking at the taskbar.  This section of the panel docks the launch 

applications currently running. The architecture of the Linux desktop removes the need 

for task manager. 

The pager displays thumbnails of the virtual windows of the desktop. The user can click 

on any of the thumbnails and go to a numbered virtual desktop. The user can also send an 

open application to any of the virtual desktops he or she pleases.  

The icon tray has a configurable clock with date settings and the presence of instant start 

application icons. When the user clicks on the clock, a calendar program launches. The 

reader will also notice icons of those applications with quick launch capabilities from the 

panel. 

Icons on the desktop behave similar to the Mac's single click initiation without Genie or 

the double-click orientation of MS Windows. Using the first run Configuration Wizard, 

the reader can immediately see that they have control over the desktop’s behavior. 

In this section, one objective exists to familiarize the reader with the similarities and 

differences between the default Linux desktop and Windows. This can help to remove a 

perception of a long learning curve. 

Additionally, many native applications familiar to Mac OS X users exist on the default 

Linux desktop. We'll want to provide the reader with an orientation of these also. Each 

item of the default desktop will get a thorough examination. We can also use this section 

to add tips and tricks known to very few users. 

Chapter 1: The First Clicks 

Linux is a multi-tasking, multi-user system that many people can use without interfering 

with others who share it. Users can also configure Linux as a powerful file, print and 

application server. Remote desktop users can maintain home directories on Linux without 

logging onto the system console directly.  

Often, people do share a Linux personal computer at the console. Each user of the system 

can have a unique user identity and password. Each user will have a personalized 

desktop, his or her applications and data. Each user’s home desktop environment can be 

unique. 

Home Directory 

The user’s data, folders, shortcuts and configuration files exist in his or her home 

directory represented graphically as a folder. Users view their home directories with a 
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program called Konqueror.  On the desktop Konqueror’s applet resembles a house. A 

user will fill this up with new folders, organized files, backups and so on. 

When a user logs into Linux, they actually log into their home directory. The graphical 

desktop they use belongs to the home directory. When you open Konqueror, you will see 

a folder called desktop. If you click on it, you will see thumbnails of the items on your 

desktop. 

 The Desktop Hub 

The Linux developers made Control Center the hub of Linux customization for desktop 

users. The Control Center handles important functions like connecting to the Internet, 

configuring email clients, determining how the file manager behaves and more.  Other 

elements handle cosmetic aspects of customizing Linux. 

First Start 

When Linux first starts up, new users discover a familiar interface. A strip runs along the 

bottom of the screen called the panel and a menu launcher icon sits on the left of the 

panel.  

If a user wants the Linux desktop to behave like MS Windows they can chose that option. 

They discover soon enough that subtle differences exist in the structure of the directory 

and the window they see when they open a folder like "My Documents". We want them 

to have fun and grasp the navigation of windows and directories quickly.  

Existing Linux users will find new features to discover for increasing their productivity. 

Fortunately, Linux has many ways to configure the behavior and appearance of windows 

and directories rarely known to Linux users. 

Configuration Wizard 

If a former Windows user wants their desktop to function like Windows 95, Linux can 

accommodate that desire using the Configuration Wizard, which offers a fast option to 

tell Linux how to behave. 

One the first run, Linux presents the Configuration Wizard to give the user the control 

they seek. Unfortunately, most users click "skip" and do not use the Wizard. We want to 

tell them why they should use the Wizard. 

Afterward, the user can access appearance and behavior options such as: 

Start button->Control Center->Look and Feel ->Window->Decoration->Redmond 

The same options exist for former Mac and Solaris users. The path is the same as above 

with the exception of selecting ->Quartz at the end for Mac and ->CDE for Solaris users. 
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Choosing and Configuring the Default Desktop 

This feature allows the user to go through the look and feel options with the wizard they 

may have dismissed on their initial opening of the Linux Desktop. We want this to be a 

tip that alerts the reader to something they missed. 

Start button->Control Center->Desktop Setting Wizard 

Look and Feel Options 

This section provides fertile ground for configuration.  Some may consider these features 

as eye candy. Initially, we will stress the ones that provide functionality.  As users gain 

knowledge of the personalization options, they can choose the look and feel that supports 

the type of work they do or their personal preferences.  

We want to use many examples to demonstrate the plethora of options and settings 

available to the readers and how the options benefit them. 

Similar to Microsoft Plus for Windows 95 and XP, Linux desktops have themes, which 

provide the reader with much flexibility in configuring the look and feel of their desktop 

environment. Themes provide users with a sense of control over their computer. 

Configuration of themes helps them learn to further explore their Linux desktop. 

The reader should also know how to log in and shut down Linux and why these functions 

have importance. An example of a fragmentation warning can focus the reader’s attention 

on this subject. 

Linux desktops provide similar log off and shut down mechanisms as Windows and 

Macintosh. If the user relates performance to their habits of starting and stopping the 

system, often they become mindful of these important steps. 

Initially, we want the reader to attain basic skills in desktop configurations. These skills 

involve: 

Using the Taskbar  

Linux provides a considerable boost to the PC user's productivity. The taskbar has a 

significant number of features and functions. Knowing how to use the taskbar will 

provide the user with productivity enhancements. For example, the use of the clipboard in 

Linux provides the user with the ability to recover multiple entries. 

Many personal computer users can remember times when they wish they had a clipboard 

with a history.  With Linux's clipboard, several buffers exist to preserve cuts and copies 

of text and images. Linux could even suffer a power failure and the clipboard history will 

remain in their buffers when the machine becomes operable again. 

Using the File Directory, Dealing with Open Windows Chaos 

This section can benefit the user in knowing how to access and organize data files. Many 
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reasons exist for approaching this topic including a user accidentally changing 

permissions on a file or directory that freezes the system.  Here we find some 

considerations for content: 

Linux users have easy access to the operating system through their terminal or console. 

By explaining the directory tree of the Linux operating system, we warn the user to limit 

their access to the system under the hood by illustrating consequences. 

We want to provide the user with the ability to change the Directory Views from icons to 

lists to details. This often helps in locating documents one might need. The directory in 

list mode provides sorting capabilities on name, type of file, date and size.  

Avoiding open windows chaos problems requires knowledge of how to use the task bar, 

virtual desktops and application banking.  Each one of these features provides users with 

navigational control. 

Again, this section provides fertile ground for extensive guidance for the user. A central 

exercise can have the user open a random number of windows. Next, the user can use the 

task bar and virtual desktops to sort the windows into a coherent mix. This exercise 

provides a powerful example of how the user can benefit from the multi-tasking features 

of Linux. Users will realize they can perform multiple tasks without crashing or freezing 

the system. 

  

Chapter 2: The MyLinux Place 

 This section could have a sub-title called personalizing the desktop.  Many of the 

misinformed assumptions about Linux result from people who fail to investigate the 

Linux Desktop. Even early veteran Linux users rarely know about the power of their 

graphical desktop. When they learned to use Linux they restricted themselves to the 

command line interface (CLI). They learned Linux without installing X.  

For new Linux users learning this system can help them with productivity.  The subject 

matter in this section provides an opportunity to share some compelling information.  

Many knowledge workers will learn to master some Linux’s techniques that will make 

them power users. 

In this section through examples and screenshots one can discover how to fully customize 

the user's desktop.  

Advanced use of the Desktop Settings Wizard 

Little things in the nooks and crannies of the Linux desktop have an effect on the user’s 

work. You might not think that icon zooming would. When your mouse glides over an 

icon the event enlarges the object and the user sees a thumbnail, which allows him or her 

to find a memo, document or application quickly.  
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System Behavior similar to Windows, Mac, UNIX or Linux 

Linux gives the user a chance to get started quickly. The developers of the Linux Desktop 

came from a variety of backgrounds. They realized that even they experienced a learning 

curve in using their original desktop. The developers isolated behaviors so users would 

feel at home. 

Here are options the user can configure: 

Window activation: The user can set the window behavior to activate a window by 

following the mouse or by clicking on it. 

Title bar: The user can select double or single click to send window to the background, 

shade window, or minimize the window. 

Mouse selection: The user can launch an application by a single click or double click 

Application Start-up notification: The user can select a busy cursor such as an hourglass 

or not. 

Keyboard Schemes: The user has the choice of a Windows scheme with a 104 keyboard, 

the Mac scheme or the UNIX scheme.  

Other options include: 

 Desktop wallpaper 

 Fading menus 

 Fading tool tips 

 File manager background  

 File manager icon animation  

 Icon Highlighting 

 Panel Icon Zooming  

Linux developers use the term panel or Kicker when referring to the entire bar across the 

bottom of the screen. Kicker holds the task bar, programs, files, folders and disks many 

of which are dragged from the desktop or an open window. When the mouse passes over 

the various icons on Kicker the size of the icon increases with a zooming effect if 

configured.   The primary use of icon zooming allows the user to see what they 

minimized quickly. 
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Additional options include: 

 Image, text and file previews 

 Smoothed Fonts (Antialiasing)  

 Sound Theme 

 Window Moving and Resizing Effects  

Style has a special meaning within Linux as each distribution provides a default look and 

feel, which the user can change. 

  

Chapter 3: Getting On-Line 

Linux comes with a clever wizard that can have one up and running with an Internet 

connection in just a few minutes. 

Getting Ready 

Many readers will have only limited understanding of configuring their dialer to connect 

to an Internet Service Provider. This section of the manuscript will walk them through a 

configuration wizard that connects to them to a service provider. Alternatively, the user 

can go directly to menu->Internet-> KPPP and enter their ISP information directly. 

Two methods exist to use an Internet connection: 

DHCP: This represents the standard protocol of most users. The acronym stands for 

Dynamic Host Configuration Protocol. The ISP’s DHCP Server provides an IP address 

and the DNS server information without user intervention. 

Static IP Address: This method allows the user to connect to the ISP as if the Linux 

computer belonged in a Wide Area Network (WAN). If the ISP provides the user with a 

static IP address, the reader can set up his or her Internet connection through their 

network configuration tool. 

Information the user needs before starting their connection: 

 ISP modem pool phone number 

 Username and password for your ISP 

 ISP's DNS servers two are sufficient  

 Information for full access to the ISP's services are: 
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 The incoming mail server address pop3.isp.net or mail.isp.net 

 Also find out if your ISP uses the POP3 protocol or IMAP. 

 The outgoing SMTP mail server address that might have the same URL as the 

incoming mail server, often it is called smtp.isp.com 

 The Usenet News also known as NNTP server address possibly news.isp.com or 

nntp.isp.net 

 Any proxy servers the ISP has set up 

Built for Broadband       

Linux networking works with DSL or Cable well. In the event the reader has an always-

on Internet connection he or she does not need a dial-up modem. Instead the computer 

needs an Ethernet network card. Linux recognizes the chipmaker on the card and 

configures networking automatically. 

 Connecting by Dial-up Modem 

Setting up a connection with the dialog based setup is as easy as using the wizard. 

The reader can reach the setup dialog the same way he or she did with the wizard.  

Menu->Internet-> KPPP. When the user clicks on the icon, a screen view of the modem 

dialer opens on the desktop. On the lower left of the screen a button with the text label of 

setup provides the text boxes for the user to put his or her ISP information. 

Modem Sessions 

A Modem session allows a user to interact with the modem directly.  Those users familiar 

with modem commands can simply type them in the console and the modem will 

respond.  

To obtain a modem session, when no connection is active, go into Setup, then Modem 

Terminal dialog. This will open a window for interactive configuration of the modem. If 

a user types ATZ which resets your modem he or she should get an OK response. Use 

File->Close to end the session. 

Wireless Connections 

 

The Linux operating system has broad and deep support for wireless connectivity. While 

extensive materials exist about wireless Linux, for the book we can provide readers with 

simple and easy material. For readers wanting extensive information, I would refer them 

to 802.11 Wireless Networks: The Definitive Guide Creating and Administering 

Wireless Networks By Matthew Gast and the on-line article  “WAP11 to WET11: Easy, 

Cheap Wireless Bridging” by Glenn Fleishman 09/11/2002. 
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 This section provides another rich opportunity to discuss the many options available in 

the Linux kernel for wireless protocols. The primary thrust of this section lies in two 

areas. The first area discusses the wireless support in Linux and the second discusses a 

user-friendly implementation the reader can deploy. 

 

Linux Firewall 

 Once the user enables network services he or she may wish to configure a 

personal firewall. The tools for configuring a simple firewall are the two 

straightforward, graphical firewall configuration tools, which ship with Linux: 

Security Level Configuration Tool and GNOME Lokkit.  

Both of these tools perform the same task — they create broad iptables rules for a 

general-purpose firewall. They differ in approach to performing this task.  

Lokkit presents the user with a series of questions in a wizard-type interface. 

Kmenu->terminal sessions->root console-> type /usr/bin/lokkit 

The Security Level Configuration Tool presents a firewall control panel. 

Kmenu->System Settings->Security Level 

At this point the reader will see actual screenshots of each GUI and instructions 

on how to setup the personal firewall. 

 

This section also provides an opportunity to discuss services, ports and 

daemons. 

Firewalls prevent network packets from accessing the network interface of the 

system. If a request is made to a port that is blocked by a firewall, the request will 

be ignored. If a service is listening on one of these blocked ports, it will not 

receive the packets and is effectively disabled. 
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For this reason, care should be taken when configuring a firewall to block access 

to ports not in use, while not blocking access to ports used by configured 

services.  

Following are four types of Linux firewalls and notes on their advantages and 

disadvantages: 

 Network Address Translation (NAT) places internal network IP subnetworks 

behind one or a small pool of external IP addresses, masquerading all requests to 

one source rather than several 

Advantages 

 Can be configured transparently to machines on a LAN 

 Protection of many machines and services behind one or more external IP 

address(es), simplifying administration duties 

 Restriction of user access to and from the LAN can be configured by opening and 

closing ports on the NAT firewall/gateway 

Disadvantages 

 Cannot prevent malicious activity once users connect to a service outside of the 

firewall. 

Packet filtering firewalls read each data packet that passes within and outside of a 

LAN. It can read and process packets by header information and filters the packet 

based on sets of programmable rules implemented by the firewall administrator. The 

Linux kernel has built-in packet filtering functionality through the netfilter kernel 

subsystem. 

Advantages 

 Customizable through the iptables front-end utility 

 Does not require any customization on the client side, as all network activity is 

filtered at the router level rather than at the application level 

 Since packets are not transmitted through a proxy, network performance is faster 

due to direct connection from client to remote host 

Disadvantages 
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 Cannot filter packets for content like proxy firewalls 

 Processes packets at the protocol layer, but cannot filter packets at an application 

layer 

 Complex network architectures can make establishing packet filtering rules 

difficult, especially if coupled with IP masquerading or local subnets and DMZ 

networks 

 

Proxy Firewalls filter all requests of a certain protocol or type from LAN clients to a 

proxy machine, which then makes those requests to the Internet on behalf of the local 

client. A proxy machine acts as a buffer between malicious remote users and the 

internal network client machines.  

 

Advantages 

 Gives administrators control over what applications and protocols function 

outside of the LAN 

 Some proxy servers can cache data so that clients can access frequently requested 

data from the local cache rather than having to use the Internet connection to 

request it, which is convenient for cutting down on unnecessary bandwidth 

consumption 

 Proxy services can be logged and monitored closely, allowing tighter control over 

resource utilization on the network 

Disadvantages 

 Proxies are often application specific (HTTP, telnet, etc.) or protocol restricted 

(most proxies work with TCP connected services only) 

 Application services cannot run behind a proxy, so your application servers must 

use a separate form of network security. Proxies can become a network 

bottleneck, as all requests and transmissions are passed through one source rather 

than direct client to remote service connections 
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Roaming Around 

  

Traditionally, support for roaming users fallsl under Samba support. In Linux, an 

administrator might store win32 style logon scripts on the Samba server. The server 

transfers the logon scripts across a network.  When a user logs on to the network he 

forces execution of the scripts.  

Linux can also support users connecting with mobile devices when they are in networks 

that don't allow direct connections.  Networks can setup a protocol server. Possible 

scenarios could be: guests in foreign networks, users behind firewall or NATs, mobile 

phone users forced to connect to their company's server, users with multiple profiles 

wanting access to their work computer when connected to their home computer. 

  

Chapter 4: Networking 

Linux has a simple network setup configuration tool. Typically, network configuration 

occurs during installation. Most users will find themselves connected to their network on 

the first run after setup. 

The Linux kernel recognizes network interface cards such as Ethernet, ISDN 

modem, or token ring and configures the interface to connect to the network. The 

kernel drivers will recognize the network card’s chip if the manufacturer of the 

card failed to supply an appropriate hardware signature. 

The major distributions use a Network Configuration Tool, which a user can 

deploy to configure several types of network interfaces with an explanation of 

each to follow. 

 Ethernet 

 ISDN 

 modem 

 xDSL 

 token ring 

 CIPE 

 wireless devices 
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Networking has an abundance of topics with rich content for interested Linux 

users. Starting with the Linux 2.4.18 kernel, the Netfilters project has added 

significantly to the Linux kernel. This subject can cover the following features and 

detail others:  

Main Features 

 stateful packet filtering (connection tracking)  

 all kinds of network address translation  

 flexible and extensible infrastructure  

 large number of additional features as patches  

 

What can I do with netfilter/iptables ? 

 build internet firewalls based on stateless and stateful packet filtering 

 use NAT and masquerading for sharing internet access where you don't have 

enough addresses 

 use NAT for implementing transparent proxies 

 aid the tc+iproute2 system used to build sophisticated QoS routers 

 do further packet manipulation (mangling) like altering the TOS field of the IP 

header 

 

Advanced Routing 

The Linux kernel provides little known but important features worth of coverage. 

Following are the topics for brief discussion. 

 Throttle bandwidth for certain computers  

 Throttle bandwidth TO certain computers  

 Help you to fairly share your bandwidth  

 Protect your network from DoS attacks  

 Protect the Internet from your customers  

 Multiplex several servers as one, for load balancing or enhanced 

availability  

 Restrict access to your computers  

 Limit access of your users to other hosts  
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 Do routing based on user id , MAC address, source IP address, port, type 

of service, time of day or content  

Wiring the Network 

Wiring a Linux network deals with what system administrators and architects refer to as 

the physical layer of the stack. When a user open a web browser he or she begins a 

process where an application needs to communicate with the window manager which 

passes information to the shell then to the kernel, which passes the communication to the 

processor then to the network card and out to a web server. The sequential layers of 

processes have received much study and many definitions and standards.  

 

This manuscript will attempt to provide an understanding of network cards or modems so 

the reader uses the correct wires and connectors to reach another computer. The second 

computer could be next to you or on another continent. 

 

This segment of the manuscript presents pictures and diagrams of network cards, 

Ethernet cable, a hub and switch and an internal and external modem and router. 

 

Background on TCP/IP networking can give the reader a better understanding of 

networking if they have a curiosity about the subject. A side bar, for example might 

include these following leading sentences about network stacks: 

 

 In TCP/IP terminology this refers to the layers (TCP, IP, and sometimes others) 

through which all data passes at both client and server ends of a data exchange.  

 

 The term "stack" also includes utilities that support the layers of TCP/IP.   

 

 In programming, we also use the term stack to describe a data area or buffer used 

for storing function calls also called requests.   

 

Networking with Windows 

 

The primary GUI tool for configuring Linux to work with Windows is the Samba 

Configuration Tool (SSC). The user accesses this tool by Kmenu->System Settings-

>Server Settings->Samba Configuration.  

 

The Samba Server Configuration Tool is a graphical interface for managing Samba 

shares, users, and basic server settings. It modifies the configuration files in the samba 

directory. Any changes to these files not made using the application are preserved. So, if 

a system administrator comes by during lunch and changes the samba configuration file, 

it will show up in the SSC. 

 

At this juncture, the user will see a run through of the configuration with screen shots and 

explanations. 
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For more background on samba and Linux, the following information with explanation 

can prove useful to the curious reader. 

 

Traditionally, people have deployed Linux for: 

 

 File and print services 

 

 Web server hosting 

 

 Internet infrastructure services 

 

 Email 

 

In the early days of Linux, Novell servers had not embraced the Internet or its protocols. 

Many inventive Novell system engineers learned to use Linux as a bridge between the 

inside network and the Internet primarily for email. Occasionally, network administrators 

still run across older networks running Red Hat 4.2 along side a Novell 3.12 server with 

Windows 95 clients using “inbox” for their email. 

 

Linux as a server still plays an important part in Windows Networking. The catalyst for 

allowing Linux into the Windows network arrived out of the Samba project. As a desktop 

operating system, users primarily want to connect to Windows computers as a peer.  

 

In this section, we want to test a new Linux computer to see if the installation script 

correctly configured samba. If not, we want to show the reader how to configure samba 

with Linux desktop utilities.  

 

Samba:  Linux and Windows Interoperability 

Linux works and plays well with others because of the Samba Project.  

Samba 2.2 includes the following new features, which we will explain:  

 Domain logon support for Windows NT 4.0 SP3+ and Windows 2000 clients 

 Support for native Windows NT4/2000/XP printing RPCs. This includes support 

for automatic printer driver download. 

 Support for server supported Access Control Lists (ACLs). 

 Rewritten internal locking semantics for more robustness 

 Conversion of various internal flat data structures to use database records for 

increased performance and flexibility. 

 Support for acting as a MS-DFS server 

 Support for Windows 2000 Client Side Caching 

 Rewritten VFS layer 
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 Improved PAM support for account and session management 

 Rewritten password and group backend API 

 Support for storing user accounts in an LDAP directory 

 The Winbind PAM and NSS modules for authenticating PAM aware UNIX 

services against an Windows NT 4.0 domain 

 New internal messaging system between Samba server processes 

Correctly written, Linux users and desk side support technicians can set up samba easily. 

Also, changes in Windows networking paradigms show up in the various versions of 

samba. The reader may find information like the following useful: 

 

Linux and NT account manageability with Winbind 

Winbind uses a Linux implementation of Microsoft RPC calls, Pluggable 

Authentication Modules, and Name Service Switches to allow Windows NT 

domain users to appear and operate as Linux users on a Linux machine 

Winbind unifies Linux and NT account management by allowing a Linux 

computer to become a full member of a NT domain. Once this occurs the Linux 

PC can see NT users and groups as if they were native Linux users and groups. 

Whenever any program on the Linux machine asks the operating system to 

lookup a user or group name it does so on the domain controller.  Winbind hooks 

into the operating system at a low level and its redirection to the NT domain 

controller occurs transparently. 

Users on a Linux machine can use NT user and group names as they would use 

Linux names. They can change owners and permissions on files so that NT 

domain users own them. They can also login to the Linux machine and run a 

Linux X-Window session as a domain user. 

Samba uses the SMB protocol to share files and printers across a network 

connection. Operating systems that support this protocol include Microsoft 

Windows (through its Network Neighborhood), OS/2, Linux and other UNIX 

variants such as Mac OS X, FreeBSD, Solaris, etc. 
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Samba becomes useful if one has a network of both Windows and Linux 

machines regardless of size. Samba will allow files and printers to be shared by 

all the systems in the network.  Samba allows users to view their Linux home 

directories as a Samba share on the Windows machine after they log in.  

Samba 3.0 for Windows 2000 Server Interoperability 

 

In 1999, Microsoft introduced Windows 2000, which they previously called NT 5.0 as 

the successor to NT 4.0.  Microsoft changed their networking paradigm so that clients 

have to use new authentication components know as Active Directory. 

 

Samba 3.0 addresses these changes in the paradigm and we will discuss the following: 

 

 UNICODE support 

 Windows 2000 Active Directory client support 

 Winbind dual-daemon implementation 

 pluggable passdb support 

 Windows NT 4.0 Style Trust Relationship 

 NTLMv2 (LAN Manager backward compatibility and explanation of levels 

0-5) 

 One Time Migration script from a Windows NT 4.0 PDC to a Samba PDC 

 Winbind working with Samba PDC 

 Loadable RPC implementations (Remote Procedure Calls) 

 Hook for utilizing a centralized winbind id map database 

 Group Mapping support 

 Publishing printers in Active Directory 

 Non-Release Delaying Features 

 Stackable VFS 

 SAM replication 

 SMB signing 

 schannel, ntlmv2 sign & seal 

 Alternative backend for WINS database 

Plus the following interesting projects:  
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 Background updates of print queues via a dedicated process  

 WINS replication with Windows NT WINS servers  

 

File and Directory Sharing 

 

Linux provides file sharing through NFS protocol and through Samba. Some Linux 

distributions come with a unified file manager, which displays both types of shares in a 

single Network Neighborhood style Window. Xandros provides the most effective of 

these file managers and can serve as a striking example.  

 

In Chapter 19, we explore the subject of Hacking Linux. For those distributions, which 

do not provide a unified view of the network, adding LinNeighborhood to a distribution 

will provide the same functionality. 

 

Using a graphical view of a network, we can explain how to share files and folders with 

other users’ computers. We can also demonstrate how to set permission on individual 

files and directories so users can share files using Access Control Lists from the domain 

user directories. 

 

Managing Groups 

Group memberships under Windows NT caused some administrators many sleepless 

nights. In the beginning, Microsoft refuted the need for Directory Services. Meanwhile, 

Novel kept and took back some market share because of their Directory. Let’s look at the 

Microsoft problem to provide an appreciation of Linux groups. 

Pretend that I belong to the bookkeepers domain and I have only read-only access to the 

financial statements because I belong to that group or perhaps domain. Then, someone 

discovers I was a CPA with Federal Government Security Clearance and training in 

counter-intelligence. So, they made me a member of the Treasury domain. 

My first new assignment involves tracking down an embezzler. I go to the financial 

statement files and I cannot get write access to them. The administrator checks and says 

he added me to the right group. Everyone in the group can get access to the files, but not 

me. 

After many hours, technical support discovers that I still have membership in the 

bookkeepers group, which has no rights to access the files I need. When tech support 

removes me from the bookkeepers group, I suddenly have access to the files I need. 

Manipulating groups in Linux provides an effective as a tool for allocating permissions. 

If several users need access to a file, for instance, one can create a special group and give 

the group ownership of the file.  



 34 

In this case, a user can set the file group as readable and writeable giving all group 

members access. Files and directories have user and group permissions.  

This section on group permissions provides significant material to demonstrate how the 

graphic user interface in Linux provides a user-friendly way to manage groups and 

subsequently projects. I added the information below from a GNU manual page to show 

the cryptic nature of what a user would face without Linux Desktop tools such as user 

manager: 

chmod changes the permissions of each given file according 

       to  mode, which can be either a symbolic representation of 

       changes to make, or an octal number representing the  bit 

       pattern for the new permissions. 

 

       The  format  of a symbolic mode is `[ugoa...][[+-=][rwxXs- 

       tugo...]...][,...]'.  Multiple symbolic operations can  be 

       given, separated by commas. 

 

       A  combination of the letters `ugoa' controls which users' 

       access to the file will be changed: the user who  owns  it 

       (u),  other users in the file's group (g), other users not 

       in the file's group (o), or all users  (a).   If none of 

       these  are  given, the effect is as if `a' were given, but 

       bits that are set in the umask are not affected. 

 

       The operator `+' causes the  permissions  selected  to  be 

       added to the existing permissions of each file; `-' causes 

       them to be removed; and `=' causes them to  be the  only 

       permissions that the file has. 

 

       The letters `rwxXstugo' select the new permissions for the 

       affected users: read (r), write (w),  execute  (or  access 

       for directories) (x), execute only if the file is a direct- 

       tory or already has execute permission for some user  (X), 

       set  user  or group ID on execution (s), save program text 

       on swap device (t), the permissions that the user who owns 

       the  file  currently  has for it (u), the permissions that 

       other users in the file's group have for it (g), and  the 

       permissions  that other users not in the file's group have 

       for it (o). 

 

       A numeric mode is from one to four octal digits  (0-7), 

       derived by  adding  up the bits with values 4, 2, and 1. 

       Any omitted digits are assumed to be leading zeros.   The 

       first  digit  selects the set user ID (4) and set group ID 

       (2) and save text image (1) attributes. The second digit 
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       selects permissions  for the user who owns the file: read 

       (4), write (2), and execute (1); the third selects permissions 

       for  other users in the file's group, with the same 

       values; and the fourth for other users not in  the  file's 

       group, with the same values. 

 

I understand the manual page information clearly. Recently, I asked a very 

knowledgeable UNIX administrator to explain the above information to me and he had 

difficulty doing so. Manual pages provide a valuable resource for Linux users. This book 

can help a reader use and understand man pages.   

 

Dialing in from the Road 

 Linux provides several methods for gaining access to a network remotely. Remote 

Access Dial-in User Services or RADIUS provides an old standard. Combined the 

Virtual Private Networking (VPN), remote users can log on to their desktops and use   

  

Chapter 5: Mail, Instant Messaging and Address Books 

Mail, scheduling and address books have taken on an important role in personal 

computers. Analysts such as the Radicati Group and Messaging On-Line believe that 

client suites such as Microsoft Outlook, Lotus Notes and Novel GroupWise number 500 

million such clients. Linux comes packaged with an Outlook clone called "Evolution" 

written by Miguel de Icaza of Ximian Corporation.  

Kmail, Evolution and Netscape Mail 

Linux supports a number of email clients also referred to as Mail User Agents or 

MUAs. Evolution from Ximian, Inc. remains a popular email client. Evolution 

requires gnome support and many versions of Linux do not provide the gnome 

libraries or Evolution. 

The KDE client team based kolab on enhanced versions of KMail, KOrganizer 

and other KDE components. Kmail holds a considerable amount of Linux user 

share since many distributions do not provide gnome support. Developers began 

including the advanced KDE components with the release of version 3.1. 

Netscape and Mozilla mail continue as the most popular mail clients for Linux. 

Prior to the release of either KDE or gnome, Netscape provided the only 



 36 

graphical browser for Linux and the only X Window based email client. Netscape 

also provides a free IMAP mail account with its browser.  

Palm Device Support 

Evolution and KDE PIM support two-way synchronization between the calendar, 

address book and task list. Evolution has limited its synchronization to Palm 

handheld devices. KDE’s PIM team has developed synchronization with multiple 

Palm handheld devices. The kolab client uses Ksync, which scans for data on 

devices using Windows CE, Visor and others. 

Setting Up Mail  

Each of the email clients mentioned here use wizards to initially set up email accounts.  

Even when you wish to add another account, the wizards run. In Netscape one can add an 

account by evoking the Wizard Edit-> Mail and Newsgroup Account Settings->Add 

Account. From that point the user enters the type of account to add, his or her name and 

email address. The next screen asked the type of incoming server Pop or IMAP, the name 

of the incoming and outgoing servers. Next the wizard requests the user name given to 

you by your provider and account name you wish to use for that account such as WORK.  

At that point the account becomes active. 

You can edit email account properties in Netscape by clicking on the Edit dropdown 

menu. The sequences runs Edit->Mail and Newsgroup Account Settings->Account name-

>Server Settings.   

Kmail and Evolution use similar wizards to Netscape. For Kmail the sequence of steps 

start with Settings->Configure Kmail ->New and the configuration wizard becomes 

active. Within Evolution the sequence starts with Tools->Settings->Mail Accounts->Add. 

Checking Your Mail 

Linux provides several options for checking mail for our discussion including fetchmail, 

proc mail, spam assassin. We can also discuss tools that alert the user than mail has 

arrived. 

Address Book 

 

Linux provides many options for an address book. The user should have some warning of 

the differences. This section provides an opportunity to write a script to synchronize 

multiple address books.  
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News Reader 

Netscape Mail and KDE provide for access to newsgroups. This section can provide a 

clear understanding of Newsgroups, IRC channels and mailing lists. 

  

Chapter 6: Sounds and Video 

Linux has a rich heritage of providing recorded entertainment. Many of these 

capabilities came from Silicon Graphics (SGI), the original leaders in commercial digital 

rendering. In 1999, SGI produced the special effects for every motion picture nominated 

for the Academy Awards. Today, moviemakers have turned to Linux for almost every 

aspect of production and special effects. In the meantime, SGI supports Linux on its 

workstations and rendering servers. 

iPod in Linux 

 

Three types of portable MP3 players exist on the market - flash-based players, MP3 CD 

players, and hard drive-based players. 

 

When Apple released the iPod for the Mac it received immediate market acceptance. 

Apple’s iPod falls into the category of hard drive-based players. The iPod combines large 

storage capacity, portability, and ease of use.  It uses a touch-sensitive scroll wheel, 

simple navigation buttons and a LCD display for browsing a music collection. 

Several Linux based projects focus on the iPod with Gtkpod considered the most 

stable. 

Gtkpod allows a user to upload songs and playlists to an Apple's iPod. Gtkpod 

supports ID3 tag editing, multiple charsets for ID3 tags, detects duplicate songs, 

allows offline modification of the database with later synchronization, and more. 

The basic list of features of Gtkpod include: 

 Reading an existing iTunesDB and import the existing contents of an iPod. 
 Adding mp3 single files, directories or existing playlists to the iPod. A user can 

choose the charset the ID3 tags are encoded from within gtkpod. The default uses 

the charset currently used by the locale setting. 

 When adding songs, gtkpod detects duplicates. 

 Removing songs from the iPod. 

 Creating and modifying playlists. 

 Modifying of ID3 tags – updating changes in the original file.  

 Refreshing ID3 tags from file if changing the tags in the original file 
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 Writing the updated iTunesDB and adding songs to an iPod. 

 Working offline and synchronizing new playlists / songs with the iPod at a later 

time. 

In the above section, we can provide screen shots and discuss the interoperability of GTK 

in KDE. 

How the Linux Works with Disks 

If the reader lacks a background in UNIX, the reader can learn to appreciate how Desktop 

Linux makes disk management easy. Once upon a time, a user needed an administrative 

right to mount any external disk. Today, Linux uses an auto-mount feature so one can 

insert a CD or DVD without special privileges. 

Administrators setup the system’s disk partitions and network mounts from servers 

during installation. The scheme for the system resides in a configuration file known as 

fstabs. We can discuss this for issue recognition and illustrate the Disk Management 

utility for Desktop Linux. 

Also during installation, the setup script can partition the disks automatically. It also 

offers the user options to partitio the disk. The subject of partitions has some valuable 

content.  

Burning CDs and DVDs 

From the first time learner to the Linux sophisticate, X-CD-Roast provides users with a 

high quality CD/DVD R/RW burner. This application provides considerable content for 

discussion such as the feature list suggests. 

 Setup and intuitive X11 user interface  
 GUI based on GTK+ instead  

 Copies most data/mixed-mode/audio-CDs  

 Master data-CDs and rearrange audio-CDs  

 Create your own audio-CDs  

 Multi session/Bootable CD creation.  

 Supports most SCSI/ATAPI/Parallel/Firewire/USB-CD-Writers available  

 Supports different international languages  

 CDDB-Lookups and CD-Text writing  

 Online help  

 Administration mode for usage in computer pools.  

 Runs on most common Unix-Operation-Systems (Primary platforms: Linux and 

Solaris)  

 DVD-Writing  
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 X-CD-Roast works as a front-end GUI for cdrtools. This tool kit uses CLI 

commands for creating non-commercial CDs with a CDR/CDRW recorder. 

Features include: 

 IDE/ATAPI, parallel port, and SCSI drives 

 Audio CDs, data CDs, and mixed CDs 

 Full multi-session support 

 CDRWs (rewritable), TAO, DAO, RAW 

 Human-readable error messages 

 Remote SCSI support  

 Access to local or remote CD writers 

 

Prior to inclusion in the cdrtools, users found the mkisofs utilities available for 

premastering ISO9660 filesystems. The output of mkisofs provided material in 

many formats, including Rock Ridge, Joliet, and Apple HFS for CD R/RW 

applications.  

DVD recording utilities known as cdrecord-ProDVD exist for Linux and work with X-

CD-Roast. This area will require discussion about Digital Millennia Copyright Act of 

1998, the use of Linux DVD recording formats and access to Open Source decryption 

formats. 

Commercial DVD Burners: 

Gear Software and Storage Heaven of Multi Media Effects provide commercial 

DVD burning solutions for Linux. 

DVD Players 

The two most popular DVD players comes from Ogle at Chalmers University of 

Technology in Sweden and xine from the SourceForge Projects. Both provide 

multimedia players for CDs, DVDs, and VCDs. They also decode multimedia files 

like AVI, MOV, WMV, and MP3 from local disk drives, and display multimedia 



 40 

streamed over the Internet. They interpret the most common multimedia formats 

available.  

With Ogle we find that it: 

 Supports DVD menus and navigation.  
 Reads from mounted, unmounted DVDs and hard drive.  

 Reads encrypted and unencrypted DVDs using libdvdread/libdvdcss.  

 A new MPEG2 decoder with MMX, Altivec and SUN Solaris mediaLib 

acceleration.  

 Uses normal X11 and XFree86 Xvideo display support with subpicture overlay.  

 Audio and sub picture selection.  

 Handles advanced sub picture commands such as fade/scroll and wipe.  

 Detects and uses correct aspect for movie and menus.  

 Can play AC3 via S/PDIF with an external command.  

 Provides full screen mode.  

 Allows for screenshots with and without sub picture overlay.  

 Supports title/chapter search.  

 Supports AC-3, MPEG and LPCM formats. 

libdvd 

Linux DVD players use a proprietary library known as libdvd. libdvdcss provides a cross-

platform library for transparent DVD device access with on-the-fly CSS decryption. This 

library exists for a number of DVD players including libdvdread and VLC because of its 

portability lack of a requirement for a DVD to be region locked. 

This topic requires discussion similar to cdrecord-ProDVD above. 

  

A Complete Recording and Editing Studio 

The Analog Real-Time Synthesizer, or aRts, synthesizes sound and music on a digital 

computer. The user can easily build complex audio processing tools from smaller 

modules. Modules provide functions such as sound waveform generators, filters, audio 

effects, mixing, and playback of digital audio in various file formats. 

The artsd sound server allows the user to mix audio from several sources in real time. It 

allows multiple sound applications to transparently share sound hardware. 

Using KDE’s Multimedia Communication Protocol, multimedia applications can be: 

 Network transparent 
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 Authenticated for security and  

 Cross-platform 

They can have interfaces defined in a language-independent way using IDL.  

 

Chapter 7: Programs, Utilities and Applications  

Linux provides a robust and functional set of native applications, which rival highly 

configured Mac and Windows platforms.  We want to introduce the reader to Linux's 

native applications for productivity. Such native applications include: 

Internet Applications equivalent to Hummingbird Exceed and fully equipped web 

browsers, graphical ftp and secure shell telnet tools. 

Office Productivity Suites  equivalent to MS Office Deluxe and tools similar to 

FrameMaker 7.0, Adobe Acrobat and PageMaker. 

 

Email and Instant Messaging equivalent to Microsoft Outlook and Act 2000. 

 

Graphics programs equivalent to Photoshop, GoLive, Illustrator, ADCSee, etc. 

 

Multi-media products for mixing, utilizing midi, ripping MP3 from CD ROMs, feeding 

digital images from Cameras and Scanners. 

  

Chapter 8: Native Programs, Free Programs 

You get the largest assortment of preinstalled programs with Linux than any other 

Operating System. These programs fall into either the free utilities category like Internet 

Wizard or applications that people normally purchased separately. These include 

OpenOffice instead of Microsoft Office standard or GIMP instead of PhotoShop.  In most 

instances, Linux applications perform as well as their costly equivalents. People quickly 

learn and adapt to these free application suites and discover enhanced features. 

OpenOffice Word Processor 

The OpenOffice.org suite contains several applications for creating and editing 

documents, spreadsheets, slide shows and artwork. Users today work with or received 

MS Word or MS Excel files, commonly associated with the Microsoft Office suite. The 

OpenOffice.org suite reads, edits and create files in several formats including files 
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associated with Microsoft Office. 

 

To start OpenOffice.org Writer from your desktop panel, choose Main Menu -> 

Office -> OpenOffice.org Writer  

The main interface is the document editing area.  At the top of the window 

toolbars control fonts, letter sizes, justification and other text formatting. Widgets 

or icons exist for opening, saving, and printing documents. 

Spreadsheet 

In every industry the use of spreadsheets has become a valuable financial tool. 

OpenOffice Calc provides a spreadsheet application for manipulating data in 

cells organized columns and rows. Spreadsheet users familiar with Lotus 1-2-3, 

Microsoft Excel and Quatro Pro will appreciate the familiar interfaces. 

To start OpenOffice.org Calc from the desktop panel, select K Menu -> Office -> 

OpenOffice Calc. To start OpenOffice.org Calc 

Graphics and Desktop Publishing 

 The GNU Image Manipulation Program (GIMP) is a Photoshop clone. A strong 

case exists for making a comparison of the Linux desktop with GIMP and the 

Mac Desktop with Photoshop. A demonstration of how each uses the desktop as 

a layout tool and complete pallet can show readers the power of the Linux 

desktop. Additionally, we can demonstration many of GIMP standard features, 

which require plug-ins in Photoshop. 
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GIMP Basics 

To use the GIMP, you will need to know some of the basics. From a shell prompt, 

you start the GIMP using the command gimp. Start the GIMP from the desktop 

panel by choosing KMenu -> Graphics -> The GIMP.  

 

Web Development 

 

Linux provides a robust development environment for WebServices and traditional web 

development from the first HTML version through HTML 4.2 and XHTML. Apache 

gives Linux a cornerstone for web development.  

 

In this section, tools for building web pages will include a discussion of Apache, Perl, 

mod Perl and PHP.  

 

This discussion will provide issue recognition. We will point out GUI web development 

tools including: 

 

 BlueFish 

 

 Mozilla Composer 

 

 Quanta Plus 

 

 

 

Tools for Developers 

Linux has a rich set of free developers’ tools from the GNU, Troll Tech and GTK. 

This section will focus on the GUI tools, giving descriptions of each and demonstrating 

Glade and Qt Designer, which use an IDE to build applications.  

Additionally, this section would benefit from a demonstration of a CLI programming 

example using the GNU compiler, the DDD GUI debugging program and RCS, the 

revision control program. Aside from the coding and debugging, demonstrating RCS 

checkins and checkouts will provide readers with an understanding of why Linux has 

become a leader in application development.  

 

You will find the following list of GUI tools available: 
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 Bluefish 

 K Develop 

 Cervisa – CVS Frontend 

 Debugger 

 DDD 

 K Babel –translation tool and manager 

 K Bug Buster 

 Qt Designer 

 Quanta Plus 

 Memory Profiler 

 Glade 

 Glade Interface Designer 

 Bug Reporting Tool 

 Kompare (Diff/Patch Frontend) 

 

Qt is a multi platform C++ application framework that lets developers write single-source 

apps that run natively on Windows, Linux/Unix, Mac OS X, and embedded Linux. Troll 

Tech claims that developers have build thousands of successful commercial applications 

worldwide using Qt.  The primary showcase product for Qt is the KDE desktop 

environment.  

 

GTK+ is a multi-platform toolkit for creating graphical user interfaces in C. GTK+ 

provides an IDE known as glade. GTK originated as the toolkit, which built the GNU 

Image Manipulation Program (GIMP). Developers have added numerous components, 

which the development teams say compose a complete set of widgets.  GTK+ is suitable 

for small one-off projects to complete application suites. GTK+ is the basis of the gnome 

desktop project. With gnome extensions, GTK+ provides an impressive development 

environment. 

GNU needs exposure in this manual. An overview and a few utilities examples suffice. 

The reader may want to know something about GNU since many people insist on the 

Linux brand becoming GNU/Linux. Accompanying commentary about GNU, references 

to specific pages on the their web site will provide adequate content for the reader. 

 

 

 

Instant Messaging 

 

Linux can tap into several Instant Messaging formats with a client called GAIM. Gaim is 

a multi-protocol instant messaging client for Linux, BSD, MacOS X, and Windows. It is 

compatible with AIM (Oscar and TOC protocols), ICQ, MSN Messenger, Yahoo, IRC, 
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Jabber, Gadu-Gadu, and Zephyr networks.  
 

Gaim users can log in to multiple accounts on multiple IM networks simultaneously. This 

means the user can chat on AOL Instant Messenger and on Yahoo Messenger while 

sitting in an IRC channel all at the same time.  
 

Gaim supports file transfer, away messages, typing notification, and MSN window 

closing notification. Gaim integrates with GNOME 2 and KDE 3.1's system tray. This 

allows a user to work with gaim without requiring the buddy list window to be up at all 

times.  

 

Free and Commercial Linux Programs 

 

A Word About the Commercial Software Companies 

 

As you look through the list of products below, you should see a definite trend in 

commercial offerings. The majority of products for Linux fall in the categories of 

databases and development tools. Commercial software companies like Adobe, Corel, 

Microsoft, Intuit, Act and Tax Cut have not ported their products to Linux.  

 

Some commercial software companies like Adobe have created an Acrobat Reader for 

Linux. You will also find Netscape, AOL Instant Messenger, Opera, Real Audio and a 

few others making gestures toward Linux. 

 

While the industry claims that Sun Microsystems dislikes Linux, you might notice that 

they offer a complete office productivity suite for end-users. They also paid for the 

OpenOffice project. Sun also offers its Java Developers Kit and run-time environment to 

Linux.  

 

The Linux development community smiled and created more, better and different 

software and most of it is free. Instead of Intuit’s Quicken, Linux has GNUCash. Instead 

of Microsoft Word, Linux has Open Office Writer and AbiWord.   

 

You will discover as you become familiar with Linux that you don’t miss much. If we 

don’t have it by brand name, we have an alternative. If you can’t buy Toast for Linux, 

you can install X-CD-Roast, which does more and works better anyway. If we don’t have 

Photoshop, we have GIMP, which some commercial artists already prefer.  

 

Let’s take a look at the commercial companies and then we can look at the Linux end 

user applications. 
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IBM  

Before Louis V. Gerstner, Jr. retired, IBM made a strategic move to port Linux to 

every brand in their hardware line. The new chairman Samuel J. Palmisano continued 

the Linux initiative. Several Linux opportunities at IBM remain in the pipeline since 

before Palmisano took over. After the pipeline clears, we will have a better indication 

whether or not IBM intends to continue emphasizing Linux. 

IBM has seemed slow to take Linux out of the data center. Many Lotus products may 

already have ports to Linux. The AIX code for Lotus Notes compiled without a hitch on 

Linux in 1999. A large faction within IBM discriminated seems to want to keep Linux as 

a server offering.  

The software you see listed below came from the IBM catalog found on their web 

site. You will notice that the products below fall into the sweet spot of IBM’s 

product line. 

DB2 database V8 for Linux for development of mission critical solutions in: 

 e-business  

 Business intelligence  

 Content management  

 Enterprise Resource Planning  

 Customer Relationship Management  

WebSphere Homepage Builder V4.0 for Linux 

Informix Dynamic Server (IDS) Enterprise Edition V9.30 for Linux (E Web-only) 

Tivoli Access Manager Web Security V4.1 for Linux (E134) 

Tivoli Storage Manager V5.1.5 for Linux (E Web-only) 

CICS Transaction Gateway V5.0 for Linux on zSeries (E Web-only) 

WebSphere Application Server Enterprise Edition V4.1 for Linux  

IBM WebSphere Application Server Advanced Edition V4.0.1 for Linux 

(Development use only) - DB2 Universal Database Enterprise Edition, V7.2 (E Web-

only) 

IBM WebSphere Application Server Advanced Edition V4.0.1 for Linux 

(Development use only) (E Web-only) 



 47 

IBM WebSphere Application Server Enterprise Edition Server and Client V4.1 for 

Linux (E Web-only) 

IBM WebSphere Commerce Suite, Version 5.1 for Linux 

IBM WebSphere Studio Application Developer Integration Edition for Linux, Version 

5.0 

Oracle 

 

Oracle Corporation runs its own business on Linux and produces its complete line of 

products for Linux as well as Microsoft Windows.  

 

Oracle9i Developer Suite of application development and business intelligence tools 

following open industry standards. The suite includes the following components:  

Oracle9i JDeveloper - an, XML and SQL Integrated Development Environment 

for rapid application development and Web services run on servers, desktops 

and mobile devices.  

Oracle9i Forms Developer - a declarative Rapid Application Development tool for 

building transaction-processing applications using PL/SQL.  

Oracle9i Designer - a set of modelers with built-in generators that create 

database schema and application code.  

Oracle9i Software Configuration Manager (Oracle9i SCM) - software 

configuration tool for managing multi-developer, multi-stream projects. Oracle9i 

Warehouse Builder – a data warehouse design environment for consolidating 

fragmented data and metadata from packaged applications, custom and legacy 

applications, and Web logs into an Oracle9i database.  

Oracle9i Reports Developer - a declarative enterprise-reporting tool to create 

high fidelity reports using data sources that can be securely published in many 

format to many destination.  

Oracle9i Discoverer - an ad-hoc query, reporting and analysis tool for end users.  

Oracle9i Business Intelligence Beans - JavaBeans components for rapidly 

development of analytical applications in Java. 
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Sun  

. 
Sun ONE Directory Server 

Store and manage identity profiles, access privileges and application and network 

resource information 

Sun ONE Identity Server  
Manage secure access to Web-based resources; provides an identity system that includes 

access management, identity administration, and directory services. 

 Sun ONE Meta-Directory  

Consolidate and aggregate identity information from such disparate sources as customer 

databases, human resources applications, network operating systems, messaging systems, 

and telephone databases to build a single, unified view stored in the directory. 

Sun ONE Directory Proxy Server  

Route requests from clients to the appropriate directory server automatically through a 

referral mechanism; provides security services for the Sun ONE Directory Server  

Sun ONE Certificate Server  

Provides strong enterprise-wide security for authentication of employees, customers, and 

partners; issues, renews, suspends, revokes, and manages X.509-based digital certificates 

Solstice X.500 Directory Products  

Build a standards-based, distributed directory that offers a common storage space for 

data. 

Sun ONE Web Server Build multi platform, e-commerce Web applications; works with 

Java Servlet and JavaServer Pages technologies to generate personalized content. 
Sun ONE Active Server Pages Deploy Web sites and applications based on Active 

Server Pages (ASP) using the Apache, Sun ONE, or Zeus Web servers. 

Sun ONE Web Proxy Server Acts as a network traffic manager by collecting data from 

the network, determining where the data should be routed, and distributing it 

appropriately 

StarOffice 6.0 Office Suite - alternative in office productivity suites that runs on 

multiple operating systems, including Solaris Operating Environment, Microsoft 

Windows, and Linux. The office suite has a simple, easy-to-use interface and contains 

full-featured applications including word processing, spreadsheet, presentation, graphics 

and database capabilities.  

Java SDK     

 

Additional Commercial Software runs along the same lines. The purpose of this chapter 

revolves around how different companies use Linux as a development platform to sell 

development tools. 

 

Chapter 9: Adding MS Windows Applications 

  

Roads to Windows Applications 
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Windows applications run on Linux through the use of third-party software. This 

capability does not exist inherently in the Linux kernel or operating system. The 

simplest and most prevalent software used for running Windows applications on 

Linux is a program called Wine. It is included with many Linux distributions by 

default. It consists of a loader, which loads and executes a Windows binary, and 

a library that implements Windows API calls using their Unix or X11 equivalents. 

It does not require that Windows be installed on the computer, but will make use 

of any .dll files it finds. Wine is an open-source program that is available at 

winehq.org.  

There are also commercial solutions available that allow Windows applications to 

run on Linux. Two of these are Win4lin and VMware. They are different than 

Wine, in that they require Windows to be installed on the machine along with 

Linux, and they are not free or open sourced. Win4lin, developed by NeTraverse, 

only allows Windows applications to be used on Linux. VMware is more 

advanced and works with many operating systems including Windows, Linux, 

FreeBSD. Both of these work by allowing the Linux and Windows operating 

systems to run simultaneously, side by side. When a Windows application such 

as Microsoft Word is running on Win4lin or VMware, it is technically being 

executed in Windows, which is running simultaneously with Linux. This is 

different than Wine, which runs a loader that executes the application, but never 

starts the Windows operating system. For more information on using Win4lin or 

VMware, see Win4lin.com or Vmware.com. Always check to see if the programs 

you are using are licensed. If they are, comply with the licenses 

 Readers should understand WINE and the derivative products, which include: 

CodeWeavers Crossover Plugin 

CodeWeavers Crossover Office 

NetTraverse 
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Windows Apps in the Linux Desktop 

Microsoft Office 97 and 2000 including Word, Excel, PowerPoint and Outlook 

Lotus Notes 

Quicken 

Microsoft Internet Explorer 

Lotus Notes 

Using Windows by Virutal Network Conections  

Desktop Sharing consists of a set of applications for sharing a desktop with a remote user. 

It includes a small server and client for protocol used by the popular VNC.  

Sharing an X11 session on the server machine, rather than creating a new one (as 

required by most other Unix/Linux RFB servers), enables a co-worker to use an 

application , an administrator to fix problems on a remote computer, or the user to access 

his or her computer from home. RFB Protocol stands for Remote Frame Buffer. 

A client for browsing available sharing servers; 

Compatible with all regular VNC/RFB clients; 

Support for all modern VNC encoding, including TightVNC and ZLib;  

TightVNC is a free remote control package derived from the popular VNC 

software. With TightVNC, you can see the desktop of a remote machine and 

control it with your local mouse and keyboard, just like you would do it sitting in 

the front of that computer. 

Connections established by invitation or traditional password methods; 

A panel or kicker applet indicating if someone is connected to the running session; 

A DCOP interface (for interaction with other programs); and 

Support for KNotify events. 

  

http://www.uk.research.att.com/vnc/
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VNC  

Licensing Gotcha's 

When employing Windows software programs, users need to have the right to use them. 

If you do not have a multi-user license, you may find yourself in violation of Microsoft 

license policies. Following are requirements to use Microsoft software, such as Office on 

your Linux computer. 

 

First, you must have the original program disk and a Certificate of Authenticity. They 

also require a user manual and printed copy of the End User License Agreement on 

recent software. They also want to see a copy of your receipt of purchase. If you have an 

upgrade, you need to also have all of the above for the original software.  

Microsoft requires “OEM” software to be distributed with PC hardware.  OEM software 

that bears the name of a large computer manufacturer (e.g. Dell or Compaq) can be 

distributed only with the computer with which the software was originally purchased. So, 

if you purchased a computer than failed, you cannot use it on another computer if it bears 

the OEM markings. 

You are not permitted to use “Not for Resale”, “NFR”, “Promotional”, “Worldwide 

Fulfillment” or “WWF”.  You can use Retail Microsoft software and NFR software 

doesn’t qualify.  

Under the Digital Millennia Copyright Act of 1998, Title 17 Chapter imposed stiff 

penalties for just copying a CD-ROM. The ceiling on the financial penalties remains at 

$150,000. The court can also impose criminal penalties including prison terms. 

 

Chapter 10: Productivity with the Linux Desktop and Taskbar 

In the early part of this proposal under the section called the Linux Desktop, we 

mentioned the pager.  The pager provides an icon or thumbnail view of Linux’s virtual 

desktops from the panel. Understanding how to use virtual desktops provides an avenue 

to high levels of productivity. 

To access and configure the number of desktops you need, a user will start with Kmenu-

>Control Panel->Desktop->Multiple Desktops.  

A user can set up as many as 16 virtual desktops. At this point we want to configure six. 

We can take a look at the Window menu button. This usually shows a mini icon for the 

application. Since the user can configure the title bar of a Window, the menu button can 

be on the right or left.  For now, use the left top button with an icon of the application. 

Click on it to get a window operations menu. Shortcut: Alt+F3 opens the window menu. 

The Window Menu provides the following options: 
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 Move 

 Size 

 Maximize 

 Shade 

 Always on Top 

 Store Window Settings 

 To Desktop 

 Configure Window Behavior 

 Close  

 

Our interest in the menu involves the third item from the bottom, the To Desktop choice. 

When a user opens a browser such as Netscape, he or she can send the browser to one of 

the virtual desktops. 

Using Virtual Desktops 

In this example, I’m going to open a web development tool call BlueFish.  Kmenu-

>Programming->Bluefish. Doing this launches the web development tool. I want this tool 

in the first Window. So, I click on the Window Menu ->To Desktop->Desktop I. 

BlueFish shows up in the pager as a thumbnail in the first Desktop. 

Next I open Netscape and put it in Desktop II. In the Window Menu of Netscape, I open 

Mail and Composer. I send mail to Desktop IV and Composer to Desktop III. 

I open OpenOffice Writer and place it in Window V and I open my console in Window 

VI. The reader will see this with screen shots. 

I will logon to my web server remotely with the console using ssh, open the same file in 

BlueFish and Netscape and I am ready to begin building web pages. 

I can cut and paste code from a web site by opening it in composer in Desktop III and 

taste that in Bluefish. I can see the code from Bluefish in my Browser in Window II and 

if I like it, I can paste the code from bluefish in a file in my remote web browser. 

While this is an elementary example, imagine that you’re compiling a financial statement. 

You have Open Office’s spreadsheet program open in Desktop I. You complete a trial 

balance and then paste the numbers in an open document in Open Office Writer, which 

you have open in Desktop II. 

The Taskbar 

When I do research, I may have six tabs open in my browser, two instances of Office 

Writer and one instance of BlueFish, which has tabs for each pages open. I also will have 

several ssh sessions running on my remote web browser directory using a text based 

editor. My email stays open since I’m waiting for some code from a team member. 
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The task bar displays the applications open on the desktop. For example, I will see a 

Netscape logo on the task bar with a number five on it. That means I have five instances 

of Netscape open. When I place my mouse on the Netscape logo a vertical menu launches 

and gives the titles of the programs I have open. One may say Composer: Untitled. 

If I click on that selection and composer occupies Window III, the desktop focus changes 

to Window III from the selection in the taskbar. 

Additional Examples 

This section offers a number of examples of how Linux navigation, application 

performance and ability to connect to different computers can increase productivity. I 

plan on demonstrating those in the manuscript, 

 

Chapter 11: The Linux Directory Structure 

Linux provides a view of the entire operating system to a user. Aside from the home 

directory, a user can browse the directories and processes that live under the hood of the 

desktop. Readers should have information about: 

The Directory Tree Structure which contains a resemblance to UNIX System V or BSD. 

Mac OS X users face a similar vulnerability for users who have never used UNIX before. 

I recommend using a sidebar approach to introducing the system directory tree. I would 

also provide a set of instructions to let the user lock out views of the Linux system 

directory structure. 

The User's Home Directory and files 

The section will use Konqueror as the File Manager. We will start with Kmenu->home-

>view->hidden files. From the file manager, a demonstration of views, dragging and 

dropping of files between directories and gaining a read only view of the system directory 

from the left side bar will aid in an understanding of the system. 

 

 Shortcuts and Panel Icons 

 

Create shortcuts in the Linux desktop involves right clicking the mouse, which brings up 

a context menu. Following Context Menu->Create New->Link to Application will put an 

application launcher icon on the desktop. 

 

Right clicking the unlinked icon allows the user to locate the application, change the icon 

and configure the application and the icon’s behavior. 

 

Linux provides some opportunities to use variables in the launch command. The manual 

can provide examples to show users that they don’t have to access root to run 

applications. 
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Dragging an icon from the desktop to the panel allows the user to launch the application 

from there. This comes in handy when the user has to open an application and Windows 

occupy the entire desktop real estate.   

 

The Menu 

 

By right clicking the Kmenu icon on the panel, the user will discover a context menu 

with four options: 

 

 Move Start Application Menu 

 Remove Start Application Menu 

 Menu Editor 

 Panel Menu 

 

Within the four context menu items the user will find sub-menus. These provide the user 

with the ability to configure their desktop and home directory structure. 

 

The main choice in this section involves the menu editor, which allows the user to 

customize the menu. He or she can add or remove program sections and individual 

programs with this editor. 

 

This provides an opportunity to demonstrate several configuration options to help the 

user become most productive in his or her environment. 

 

The Trash 

 

Linux uses trash as a buffer before deleting files and objects. The UNIX command rm 

and the delete option on the right clicked context menu both by-pass trash. The icon for 

trash represents a hidden directory in the user’s home directory.  

 

Having a hidden directory for trash allows users to retrieve an item they may not have 

wanted to delete.  

 

 

 

Getting Information 

This section will provide a comprehensive discussion of the considerable resource sites 

for Linux. We will provide the easiest sites to navigate and understand such as "Linux for 

Newbies" and then categorize the remaining sites similar to Google's Directory. This 

provides a prelude to Appendix C. 
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Applications in Linux 

  

Chapter 12: Programs and Documents 

This section covers 1) downloading a Linux ISO and creating bootable distribution disks 

2) Discussing available program packages and selecting applications the user will want 3) 

Finding Linux Application Repositories such as Linuxapps.com and 4) Listing and 

describing applications which have popular commercial equivalents. 

Linux ISOs and Package Selection 

For the cost and/or effort of downloading a Linux ISO image and then burning it on 

CD/R RW a user can have the entire Linux operating system and several hundred 

programs and applications.   

Linux Repositories 

Classified repository of Linux applications exists at Linuxapps.com 

http://www.linuxapps.com. This section will refer to the applications that closely 

resemble those in commercial use.  

Linux Applications with a Familiar Touch 

 

This section provides users with familiar applications they have use on Linux and Mac. 

 

GnomeMeeting   comparable to Netmeeting 

GnomeMeeting provides videoconferencing software for Linux. This application 

complies with H.323 protocol.  A user can make audio and video calls to remote users 

with H.323 software (like Netmeeting) or hardware. GnomeMeeting supports modern 

features of videoconferencing software such as registering to an ILS directory, gatekeeper 

support, making multi user conference calls using an external MCU, and using modern 

Quicknet telephony cards.  

GnuCash   comparable to Quicken 

A personal financial manager built to resemble Quicken. GnuCash tracks bank accounts, 

stocks, income and expenses. The interface provides quick and intuitive performance for 

use as a checkbook register. The developers based this product on generally accepted 

accounting principles to ensure balanced books and accurate reports.  

GnuCash provides support for the Open Financial Exchange protocol that banks and 

financial services consider a standard. OFX and HBCI support also results in an 

improved transaction matching system that more accurately picks duplicate transactions. 

 

GNUCash provides facilities to import Intuit Quicken QIF files automatically merged to 
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eliminate duplicate transactions. 

 

 

RAV Anti-Virus   comparable to McAfee 

 RAV Anti-Virus for Linux Desktop provides an on-demand Linux anti-virus scanner 

accessible from a simple command line tool or via our GUI interface. RAV scans local 

drives for over 75,000 Linux, PC, and Mac viruses. RAV provides Linux with a widely 

used commercial application similar to NAI McAfee.  Provides protection for Samba 

shares. 

The above are examples of introductions, which resemble the population of descriptions 

of Linux applications planned for presentation. 

 

Chapter 13: Data Mobility 

 Exchanging Data with Macs, Windows and UNIX 

Sharing Files and Printers 

Sharing files and printers has existed natively for users of Microsoft Windows since the 

release of Windows for Workgroups in 1993.  Windows 95 took file and print sharing to 

a new and user-friendly level, which exists in every release of Microsoft's Operating 

System. 

Linux and the Mac OS X 1.2 use Microsoft's file system protocol for sharing files and 

printers. In Linux, the default desktop has a facility similar to Microsoft's Network 

Neighborhood, which allows a user to join a Microsoft Workgroup or Domain with Mac 

computers and UNIX shares.  

Samba 

Samba becomes useful if one has a network of both Windows and Linux 

machines regardless of size. Samba will allow files and printers to be shared by 

all the systems in the network.  Samba allows users to view their Linux home 

directories as a Samba share on the Windows machine after they log in. Please 

refer to Chapter 4 for a detailed explanation. 
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NFS 

 Network File System (NFS) comes out of the UNIX model of network computing. 

Originally, users had their home directory on a large file server and when the 

turned on their computer and logged on, their workstation mounted their home 

directory from the server.  When a directory mounts on a workstation, it appears 

to the user as part of their directory tree. 

NFS allows Linux users to share files among machines on a network as if the 

files were located on the client's local hard drive. Linux can operate as an NFS 

server and an NFS client, exporting directories to other systems and mounting 

directories exported from other systems.  

NFS is useful for sharing directories of files among multiple users on the same 

network. Users work as if the directory is on their local machines. One caveat 

concerns security. NFS directories can provide unscrupulous users with an 

opportunity to exploit a system. 

  

Chapter 14: Getting Command of the Command Line 

 Linux uses a default shell program called Bash. Running Ready-Made Scripts 

Graphical environments for Linux have come a long way in the past few years. 

You can be perfectly productive in the X Window System, and only have to open 

a shell prompt to complete a few tasks.  

However, functions can be completed faster from the shell prompt than from a 

GUI. In less time than it might take you to open a file manager, locate a directory, 

and then create, delete, or modify files from a GUI, you could have finished your 

work with just a few commands at a shell prompt.  

A shell prompt looks similar to other command-line interfaces you might be 

familiar with. Users type commands at a shell prompt, the shell interprets these 
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commands, and then the shell tells the OS what to do. Experienced users can 

write shell scripts to expand their capabilities even further.  

 Writing Your Own Scripts 

Bash scripts are collections of commands stored in a file. The shell can read this 

file and act on the commands as if they were typed at the keyboard. In addition, 

the shell also provides useful programming features to make scripts robust. 

A wide range of tasks can be automated using scripts.  In this section we will 

write an example script. 

In you text editor write the following lines: 

 

#!/bin/bash 

# My first script 

echo "Hello World!" 

The first line tells the system a program exists and which application it needs to 

interpret the script. In this case it is /bin/bash.  

The second line is a comment. Bash ignores everything that appears after a "#" 

symbol. As your scripts become bigger and more complicated, comments 

become important to remind you what you wrote when you come back to it 

weeks or months later. The last line uses the echo command to print to the 

screen.  

Next shell permissions must change to execute the script. The standard octal 

permissions use  

$ chmod 755 my_script 
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The 755 provides read, write, and execute permission to the owner represented 

by the first number in the group. Remember the first octal belongs to the owner. 

Read permissions = 4, write permissions = 2 and execute permissions =1. 

The group has read and execute permission which equals 5. The world group 

also gets a permission of 5. 

We can now run the script: 

$ ./my_script 

You should see "Hello World!" displayed.  

 Saving a Script 

Once the reader practices a few simple scripts, he or she should have a directory where 

the store their scripts.  

 Writing Commands by Hand 

A reader can easily search the Internet and find many sites, which give away free scripts. 

Free scripts have a value in learning how other people performed tasks. As a new Linux 

user, write scripts by hand. Some scripts may have the ability to make your system 

vulnerable to exploits and even notify someone of that fact. Secondly, writing your own 

scripts will allow you to become proficient in the use of them. 

 Learning Just Enough 

 In this section of the manuscript, we have an opportunity to let the reader continue 

learning more about bash scripting to different levels of proficiency or let them move to 

the next chapter. 

Chapter 15: Preferences  

  

You have worked with Control Center in early chapters. Linux also provides a menu list 

of these items in Kmenu->Preferences->n. 

The preferences offer a higher-level map of the Linux Desktop OS. Each item deserves a 

topic header, discussion and examples. 

 User Information 

 File Browsing 
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 Look and Feel 

 The Network 

 Password Control 

 Peripherals - Digital Cameras and more 

 Personalizing with Accessibility, Country and Language 

 Cryptography, Session Management, Spell Checking 

 Power Control 

 Lots of Sound and Video 

 Printing 

Printer Configuration Tool allows users to configure a printer in Linux. The GUI 

tool maintains the printcap configuration file, print spool directories, and print 

filters.  

Starting with the 2.4.18 Linux kernel, distributions began shipping with two or 

more printer systems. The Printer Configuration Tool configures the default 

printing system called LPRng. LPRng. This section focuses on using Printer 

Configuration Tool to configure LPRng.  We will also look at an alternate printing 

system called CUPS, Common UNIX Printing System. 

To use Printer Configuration Tool; select Kmenu -> System Settings -> Printing. 

This command automatically determines whether to run the graphical or text-

based version.  

 Five types of print queues can be configured:  

 Local Printer: A printer attached directly to your computer through a 

parallel or USB port uses this configuration. In the main printer list set the 

queue type for this configuration to local.  
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 Unix Printer (lpd spool): A printer attached to a different Linux or UNIX 

system with TCP/IP network. In the main printer list as shown in, the 

queue type for a remote UNIX printer is set to LPD.  

 Windows Printer (SMB):  A printer, which is attached to a different system, 

which is sharing a printer over a Windows system queue type for a remote 

Windows printer, is set to SMB.  

 Novell Printer (NCP Queue): A printer attached to a different system, 

which uses Novell's NetWare network the queue type for a remote Novell 

printer is set to NCP.  

 JetDirect Printer: HP JetDirect printers can connect directly to the network 

instead of to a computer and the queue type for a JetDirect printer is set to 

JETDIRECT.  

 

Web Browsing 

 One might consider Linux a haven for web browsers. Prior to the release of KDE 3.1, 

Linux held the post of stepchild when it came to browsers. In this section, we do not have 

to discuss the past and the misery many of us felt. Instead, we can focus on now. 

Using a commercial WINE project called CodeWeavers (http://www.codeweavers.com) 

CrossOver Office, a user can use Microsoft Internet Explorer in Linux. Additionally, with 

the same company’s CrossOver Plugin, Netscape on Linux can utilize the various plug-

ins, which have trouble working natively on Linux.  

Netscape and Mozilla have seemed sufficient for Linux distributions. Each has a Web 

Browser, Mail program, Composer WYSIWYG html tool, a newsgroup program, an 

address book and AOL Instant Messenger. Many users prefer Mozilla because it does not 

allow web sites to use annoying popup screens.  

Many people have suggested that Opera is the fastest browser worldwide. Opera 

may well hold the land speed record and other features appear more significant. 

The main features people like including support for open Web standards 

including as HTML, XML, XHTML, WML, CSS and DOM. Opera also supports 

Secure Socket Layer (SSL) versions 2 and 3. Finally, like Mozilla, Opera has 

configuration options to push pop-up windows to the background, or to not show 
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them at all. Additionally, Opera was the first browser made for Linux that offered 

renderings of web sites that required Microsoft Internet Explorer.  

Konqueror provides Linux with an Open Source web browser with HTML4.0 

compliance, supporting Java applets, JavaScript, CSS1 and CSS2, and 

Netscape plug-ins. As mentioned earlier, the rendering engine from Konqueror 

forms the basis for Mac OS X Safari Browser. Apple Computer claims that Safari 

holds the land speed record. Perhaps Opera and Apple can arrange a racing 

event. 

Konqueror operates as the file manager for the K Desktop Environment. It 

supports basic file management on local UNIX file systems, from simple cut/copy 

and paste operations to advanced remote and local network file browsing. 

Konqueror technology underlies the latest KDE technology, from KIO slaves 

(which provide mechanisms for file access) to component embedding via the 

KParts object interface, which refers to the Kroupware project.  

The project team also claims that Konqueror it is one of the most customizable 

applications available. It does provide a universal viewing application, which 

allows it to view files without opening a separate application. 

 

In this section, we have an opportunity to demonstrate the versatility and drawbacks of 

the various web browsers. The reader can also gain an understanding of the different 

rendering engines and plug-ins. 

 

  

Chapter 16: One, Many Users 

  

Managing User Accounts 

 Control of users and groups is a core element of Linux system administration.  
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Users can be either people, meaning accounts tied to physical users, or logical 

users, meaning accounts, which exist for specific applications to use. Both types 

of users have a unique User ID (UID) and Group ID (GID).  

Groups are logical expressions of organization. Groups tie users together, giving 

them permissions to read, write, or execute files.  

When a file is created it is assigned a user and group. It is also assigned 

separate read, write, and execute permissions for the file's owner, group, and 

everyone else. The creator of the file can change by root or, in most cases, the 

user and group of a particular file, as well as the access permissions on the file.  

Proper management of users and groups and effective management of file 

permissions, are among the most important tasks a system administrator 

undertakes in the course of his duties.  

 

Setting Up Accounts 

 Linux uses a graphical tool called user manager. To add a new user, click the 

New User button. A window as shown in will appear. Type the username and full 

name for the new user in the appropriate fields. Type the user's password in the 

Password and Confirm Password fields. The password must be at least six 

characters.  

Select a login shell. If you are not sure which shell to select, accept the default 

value of /bin/bash. The default home directory is /home/username. You can change 

the home directory that is created for the user, or you can choose not to create 

the home directory by unselecting Create home directory.  

Red Hat Linux uses a user private group (UPG) scheme. The UPG scheme does 

not add or change anything in the standard UNIX way of handling groups; it 

simply offers a new convention. Whenever you create a new user, by default, a 
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unique group with the same name as the user is created. If you do not want to 

create this group, unselect Create a private group for the user.  

To specify a user ID for the user, select Specify user ID manually. If the option is 

not selected, the next available user ID starting with number 500 will be assigned 

to the new user. Red Hat Linux reserves user IDs above 500 for system users 

 

Setting Up the Login/Logout Process 

 During installation, if you selected graphical as the login type, you will see a 

graphical login screen as shown in. Again, unless you have chosen to give your 

machine its own hostname, which is primarily used in a network setting, your 

machine will probably be called localhost.  

Signing In 

To log in as root from the graphical login screen, type root at the login prompt, 

press [Enter], type the root password that you chose during installation at the 

password prompt, and press [Enter]. To log in as a regular user, type your 

username at the login prompt, type your password that you selected when 

creating the user at the password prompt, and press [Enter].  

Logging in from the graphical login screen automatically starts the graphical 

desktop for you.  

 

Logging Out 

To log out your graphical desktop session, select Main Menu -> Log Out.  

When the confirmation dialog appears, select the Logout option and click the Yes 

button. If you want to save the configuration of your desktop, as well as any 

programs which are running, check the Save current setup option, as well.  
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The Superuser or Root Account 

 Setting up a root account and password is one of the most important steps 

during your installation. Your root account is similar to the administrator account 

used on Windows NT machines. The root account is used to install packages, 

upgrade RPMs, and perform most system maintenance. Logging in as root gives 

you complete control over your system.  

The root user also known as the superuser has complete access to the entire 

system; for this reason, logging in as the root user is best done only to perform 

system maintenance or administration. 

 

Use the root account only for system administration. Create a non-root account 

for your general use and su - to root when you need to fix something quickly. 

These basic rules will minimize the chances of a typo or an incorrect command 

doing damage to your system.  

To become root, type su - at the shell prompt in a terminal window and then press 

[Enter]. Then, enter the root password and press [Enter]. 

The installation program will prompt you to set a root password for your system. 

You must enter a root password. The installation program will not let you proceed 

to the next section without entering a root password.  

The root password must be at least six characters long; the password you type is 

not echoed to the screen. You must enter the password twice; if the two 

passwords do not match, the installation program will ask you to enter them 

again.  
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You should make the root password something you can remember, but not 

something that is easy for someone else to guess. Your name, your phone 

number, qwerty, password, root, 123456, and anteater are all examples of bad 

passwords. Good passwords mix numerals with upper and lower case letters and 

do not contain dictionary words: Aard387vark or 420BMttNT, for example. 

Remember that the password is case-sensitive. If you write down your password, 

keep it in a secure place. However, it is recommended that you do not write down 

this or any password you create.  

 

Chapter 17: Graphics, Fonts, and Printing 

  

Meet the Printer 

 To use Printer Configuration Tool, you must have root privileges. To start Printer 

Configuration Tool, use one of the following methods:  

 In a graphical desktop environment, click Main Menu -> System Settings -

> Printing.  

 You can also run Printer Configuration Tool as a text-based application if 

you do not have the X Window System installed, or if you just prefer the 

text-based interface. Type the command /usr/bin/config-printer from a shell 

prompt, which will prompt your for your user password before it continues.  

Making the Printout 

 After you have configured your printer, you should print a test page to make sure 

the printer is functioning properly. To print a test page, select the printer that you 

want to test from the printer list, and choose Test -> Print US Letter Postscript 

Test Page, Print A4 Postscript Test Page, or Print ASCII Test Page from the pull 

down menu. If your printer does not support PostScript printing, choose to print 

the ASCII test page.  
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Managing Printouts 

 When you send a print job to the printer daemon such as printing text file from 

Open Office Writer or printing an image from The GIMP, the print job is added to 

the print spool queue. The print spool queue is a list of print jobs that have been 

sent to the printer and information about each print request such as the status of 

the request, the username of the person who sent the request, the hostname of 

the system that sent the request, the job number, and more. To view the list of 

print jobs in the print spool, open a shell prompt and type the command lpq. The 

last few lines will look similar to the following:  

Rank   Owner/ID            Class  Job Files       Size Time 

active user@localhost+902    A    902 sample.txt  2050 01:20:46 

If you want to cancel a print job, find the job number of the request with the 

command lpq and then use the command lprm job number. For example, lprm 902 

would cancel the print job in .You must have proper permissions to cancel a print 

job. You can not cancel print jobs that were started by other users unless you are 

logged in as root on the machine to which the printer is attached.  

You can also print a file directly from a shell prompt. For example, the command 

lpr sample.txt will print the text file sample.txt. The print filter determines what type of 

file it is and converts it a format the printer can understand.  

 

 

Printer Sharing 

 Windows Printer (SMB) — a printer attached to a different system, which is 

sharing a printer over a SMB network (for example, a printer attached to a 
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Microsoft Windows machine). In the main printer list, the Queue Type for a 

remote Windows printer is set to SMB.  

PDF Files 

 With Linux printing systems, a user can print to files including PDF. When going from 

File->Print you will see several options on the print screen. On of those options includes 

Save As PDF. PDF means Adobe Acrobat Document – a universal format that can be 

viewed, printed, read and copied by Windows, Mac, UNIX and Linux users.  

Adobe never ported Acrobat Distiller to Linux. With this option you can produce the high 

resolution, universal files without paying $250 to Adobe. 

PDF files are used for numerous documents including White Papers, README files, 

manuals, marking documents, IRS Tax Forms and more.  

Linux also comes with a program called xpdf, which substitutes for the Acrobat Reader 

from Adobe. While you can still download Adobe’s reader for free, many Linux users 

prefer the native Linux PDF reader. 

  

Chapter 18: The Interactive Linux Console 

  

Consoles and Terminals 

Linux has some interesting features some of us take for granted. In 1999, I refused to use 

anything but Linux for the entire year. In January 2000, I had to setup a few test 

machines running Microsoft NT 4.0 and Windows 98SE with Outlook 98 on them. The 

NT workstation wound up in my office.  I started printing a document and noticed the 

machine became a dedicated print server. 

Out of habit, I pressed crt->alt->F2 and nothing happened. I thought for a moment and 

realized that Windows did not have a virtual console. I was stuck watching the machine 

print and couldn’t do anything else on that computer. 

On my Linux P.C. I had setup eight virtual terminals and used them. If I were compiling 

a program in console #7, then I would just open another session on console #2 and work 

on something else. I remember thinking how Linux allowed me to increase my 

productivity while I watched the Microsoft Workstation print. 

On the desktop, Linux can open numerous terminal or console sessions. In one window I 

can compile an application, log on to a remote web server and fix broken links on a web 

page and watch an IRC channel at the same time.  
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The terminal I use on Linux comes with the default KDE desktop. The developers call it 

Konsole, an X Terminal for Linux.  The distinction blurs on the Linux Desktop.  

A user can open multiple X terminal sessions on the Linux Desktop. The choices include: 

 Linux Console 

 Midnight Commander 

 Screen Session 

 Shell 

 Root Console 

 Root Midnight Commander 

A user can open one or more of these X terminal sessions at the same time.  

These terminal sessions perform differently. One of the sessions says Midnight 

Commander (MC). Actually the official name GNU Midnight Commander says that it 

comes out of the Free Software Foundation.  

Midnight Commander functions as a file manager. It has a graphical interface running 

in text mode. GNU Midnight Commander runs locally or remotely, on the console or 

under X Window System.  

MC provides an intuitive user interface to the operating system and has numerous 

functions. One might find it interesting that gnome maintains MC and it runs as an 

option in the KDE Konsole. 

At this point, the content can use screen shots of Midnight Commander and show 

some of the more interesting functions it provides. 

Navigating in Linux - The Directory Tree 

 Changing directories presents little in the way of problems if the user knows his 

or her current location in the file system.  To find out my location, I run the 

command $ pwd for present working directory. If I want to go to my home 

directory, I run the command $ cd and suddenly, I find myself at $ /home/user1/. 

To change directories, use the cd command. Typing this command by itself will always 

return you to your home directory; moving to any other directory requires a pathname.  
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You can use absolute or relative pathnames. Absolute paths start at the top of the 

directory tree and then look down for the requested directory; relative paths look down 

from your current directory, wherever that may be. The following directory tree 

illustrates how cd operates:  

/ 

/directory1 

/directory1/directory2 

/directory1/directory2/directory3  

directory3 and you want to switch to directory1, you need to move up in the directory 

tree.  

Executing the command cd directory1 

While in directory3, the system will display an error message no such file or directory. 

Directory 3 doesn’t have a directory under it named directory1. 

 

To move to directory 1 requires an absolute path which starts at the root of the 

directory tree and uses the slash symbol / to indicate the top.  If I run the 

command $ pwd and receive an answer /home/user1 then if I want to go to a 

directory above my current state, I would use the absolute path to get there. The 

command I would use is $ cd /usr/bin/. 

Without the root /, the only directory I can move to are relative to my position in 

my home directory. We refer to a command like $cd mydocs as a relative path if I 

am in my home directory. When I execute the command cd ..  then I can move 

up a directory. 
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Working with Files and Directories 

Now that you know how to change directories, it is time to learn how to view the 

contents of these directories. Using the ls command, you can display the 

contents of your current directory.  

Many options are available with the ls command. The ls command, by itself, will 

not show you all the files in your directory. Some files are hidden files (also called 

dot files) and can only be seen with an additional option specified to the ls 

command.  

 There will be times when you know a file or directory exists but you will not know 

where to find it. Searching for a file or directory can be easier with the locate 

command.  

With locate, you will see every file or directory whose name contains the search 

criterion. For example, if you want to search for all files with the word finger in the 

name, type:  

locate finger 

The locate command uses a database to locate files and directories that have the 

word finger in the file or directory name. The search results could include a file 

called finger.txt, a file called pointerfinger.txt, a directory named fingerthumbnails, and 

so on. To learn more about locate, read the locate man page (type man locate at a 

shell prompt).  

More Commands for Reading Text Files 

You have already been introduced to several basic shell prompt commands for 

reading files in text editors. Here are a few more.  
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The head Command 

You can use the head command to look at the beginning of a file. The command 

is:  

head <filename> 

head can be a useful command, but because it is limited to the first several lines, 

you will not see how long the file actually is. By default, you can only read the 

first ten lines of a file. You can change the number of lines displayed by 

specifying a number option, as shown in the following command:  

The tail Command 

The reverse of head is tail. Using tail, you can view the last ten lines of a file.  

The grep Command 

The grep command is useful for finding specific character strings in a file. For 

example, if you want to find every reference made to "coffee" in the file 

sneakers.txt, you would type: grep coffee sneakers.txt 

You would see every line in that file where the word "coffee" is found.  

I/O Redirection and Pipes 

You can use pipes and output redirection when you want to store and/or print 

information to read at a later time.  

You can, for example, use grep to search for particular contents of a file, then 

have those results either saved as a file or sent to a printer.  

To print the information about references to "coffee" in sneakers.txt, for example, 

just type: grep coffee sneakers.txt | lpr 
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Wildcards and Regular Expressions 

What if you forget the name of the file you are looking for? Using wildcards or 

regular expressions, you can perform actions on a file or files without knowing 

the complete filename. Just fill out what you know, then substitute the remainder 

with a wildcard. Wildcards are special symbols that you can substitute for letters, 

numbers, and symbols that make finding particular directories and files easier 

than examining long directory listings to find what you are searching for.  

We know the file is called sneak something txt so type: 

ls sneak*.txt 

and there is the name of the file:  

sneakers.txt 

You will probably use the asterisk (*) most frequently when you are searching. 

The asterisk will search out everything that matches the pattern you are looking 

for. So even by typing:  

ls *.txt 

or:  

ls sn* 

You would find sneakers.txt and any other files whose names begin with sn or ends 

with .txt. It helps to narrow your search as much as possible.  

One way to narrow a search is to use the question mark symbol (?). Like the 

asterisk, using ? can help locate a file matching a search pattern.  
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In this case, though, ? is useful for matching a single character, so if you were 

searching for sneaker?.txt, you would get sneakers.txt as a result, and/or sneakerz.txt, 

if there were such a filename.  

Regular expressions are more complex than the straightforward asterisk or 

question mark.  

When an asterisk, for example, just happens to be part of a filename, as might be 

the case if the file sneakers.txt was called sneak*.txt, that is when regular 

expressions can be useful.  

Using the backslash (\), you can specify that you do not want to search out 

everything by using the asterisk, but you are instead looking for a file with an 

asterisk in the name.  

If the file is called sneak*.txt, type:  

sneak\*.txt 

Here is a brief list of wildcards and regular expressions:  

 * — Matches all characters  

 ? — Matches one character in a string (such as sneaker?.txt)  

 \* — Matches the * character  

 \? — Matches the ? character  

 \) — Matches the ) character  

Online Help 

The base help files for the desktop infrastructure has documentation. Applications also 

have some on-line help. This section will show the user how to access the Linux on-line 

help.  

 

Additionally, help files can be found in the man pages, info files, documentation 

directories and README files. In this section we will demonstrate how to access man 

pages and how to read them. We will continue on to other on-line documentation using a 

problem-solving example. 
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This section will also demonstrate how to make searches on Google to find topics 

discussed in newsgroups whether from answers already given or in posting a new request 

for help. 

 

  

Terminal Preferences 

The console on the Linux Desktop provides a command line interface or CLI. 

Historically, the X-Windows Window Manager allowed UNIX administrators and 

programmers to open multiple sessions. The name Window Manager says everything one 

needed to know about X.  

 

As Graphical User Interfaces became popular in Windows and Macintosh computers, 

UNIX wasn’t to be outdone. The Common Desktop Interface also known as CDE became 

the default UNIX graphical interface. Not until April of 1998, did sophisticated Window 

Managers begin to appear.  

 

The terminal remains in the Linux desktop in KDE and gnome. In the Blue Curve 

desktop one can launch a console session by clicking on the Kmenu->Terminal Sessions-

> with the following options: 

 

 Linux Console 

 Midnight Commander 

 Screen Session 

 Shell 

 Root Console 

 Root Midnight Command 

 New session at Bookmark 

 

We will want to explain each of these options and their functions. Midnight Commander 

provides users with perhaps the best file manager.  

 

Additionally, the console windows have many configurable features. Anyone used to a 

particular terminal such as Xconsole or IBM’s 3270 and configure the console to 

resemble the screen which they had become accustomed. 

 

 

Terminal Tips and Tricks 

 

The following keyboard actions came from a GPL’d Internet site. Many such sites exist 

and provide ample material for the reader. This section provides another opportunity to 

select exercises and demonstrate short cuts to assist the reader in using Linux. The plan 

for the manuscript aims to provide the user with an understanding of the Linux 

commands structure using the bash shell.  
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  [Ctrl] + [Alt] + [Backspace] = kill X. Kills a current X session and returns 

the system to the login screen. Use this if the normal exit procedure does 

not work.  

 [Ctrl] + [Alt] + [Delete] = shutdown and reboot. Shuts down your current 

session and reboots the OS. Use only when the normal shutdown 

procedure does not work.  

 [Ctrl] + [Alt] + [Fn] = switches screens. [Ctrl]+[Alt] + one of the function 

keys displays a new screen. [F1] through [F6] are text (console) screens 

and [F7] is a graphical screen.  

 [Alt] + [Tab] = switch tasks. If you have more than one application open at 

a time, you can use [Alt] + [Tab] to switch among open tasks and 

applications.  

 [Ctrl] + [a] = move cursor to the beginning of a line. This works in most text 

editors and in the URL field in Mozilla.  

 [Ctrl] + [d] = logout of a terminal or console instead of having to type exit or 

logout.  

 [Ctrl] + [e] = move cursor to end of a line. This works in most text editors 

and in the URL field in Mozilla.  

 [Ctrl] + [l] = clear the terminal. This shortcut does the same thing as typing 

clear at a command line.  

 [Ctrl] + [u] = clear the current line. If you are working in a terminal, use this 

shortcut to clear the current line from the cursor all the way to the end of 

the line.  

 [Middle Mouse Button] = pastes highlighted text. Use the left mouse button 

to highlight the text. Point the cursor to the spot where you want it pasted. 

Click the middle mouse button to paste it.  

 [Tab] = command autocomplete. Use this command when working in a 

terminal. Type the first few characters of a command and then press the 

[Tab] key. It will automatically complete the command or show all the 

commands that match the characters you typed.  
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 [Up] and [Down] Arrow = show command history. When working in a 

terminal, press the [up] or [down] arrow to scroll through a history of 

commands you have typed from the current directory. When you see the 

command you want to use, press [Enter].  

 clear = clear the terminal. Type this at a command line to clear all 

displayed data from the terminal window.  

 exit = logout. Type this at a command line to logout of the current user or 

root account.  

 history = show history of commands. Type this at a command line to see a 

numbered list of the previous 500 commands you typed. To display a 

shorter list of commands, by type history followed by a space and a 

number. For example, history 20.  

 reset = refresh terminal screen. Type this at a command line to refresh the 

terminal screen if characters are unclear.  

 

 

Chapter 19: Fun with Linux 

 Moving Unmovable Files and Directories 

 

In this section, the Linux concepts of permissions will receive a mid-level discussion. 

Coverage of User, Group and Other permissions will follow a standard UNIX discussion 

with tips and explanations. The example of the sticky bit used in Mac OS X book works 

well for the reader I anticipate addressing.   

 

Linux exposes the root account immediately. During normal installation of commercial 

packages, the installation script will always request a root password before completing. 

So, the hidden root directory and enabling the root user does not apply to Linux. 

 

Also, the sudo command rarely receives much attention in Linux. My tendency would 

train the user in the Linux su command and the su – command. In modern Linux 

distributions users often type the su command for a limited number of privileges. In 

RedHat and Debian package managers the system prompts the user for an administrative 

password. The user can also use su. An administrator can reserve su – for himself. 
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Useful Unix Utilities 

 

Linux utilities most often seen include: 

 

ls  

less 

xkill 

ps aux 

cp and rm 

pwd 

cd 

tar 

shutdown 

whereis, find and locate 

curl and wget 

ssh 

ftp 

telnet 

rpm 

 

These Linux commands deserve attention. In additional, I would like to add an appendix 

of Linux command. 

 

Vi and vim 

 

Linux users may never need to access the command line. The Human Interface developed 

by KDE and gnome provides an adequate layer between the user and the Linux shell. 

Command line graphic programs like Midnight Commander also provide an interface 

adequate for Linux commands including a browser and a fully function editor. 

 

More likely than not, users will access the console and want to learn UNIX commands 

and utilities. I consider a short treatment of vi an essential part of gaining an 

understanding of UNIX.  Additionally, having worked on many Linux and UNIX systems 

in support capacities, I have always found vi or vim available on remote systems. I have 

used the vi editor to correct web pages, fix misspellings in configuration files or even add 

missing configuration files.  

 

This part of the book should provide the reader with a sense of command over the Linux 

and UNIX system.  

 

 

Chapter 20: Hacking Linux 

The words Linux and hacks to me are synonymous. The readers of this proposed 

manuscript may not have the opportunity to understand that. It serves the user to populate 
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this section of the book with popular GUI tools for changing their desktop and using tools 

like curl and wget to do downloads. 

Customization and Package Management 

 

Readers of the missing manual will use rpm based distributions. One of the first resources 

we can provide for hacks would be RPMFIND.  Additionally, we will go through the use 

of the package manager and demonstrate how to recognize binaries. 

 

Additionally, this section will contain material on decompressing source files and 

installing them using configure, make, makeinstall and make clean.  

 

This section has an abundance of topic areas which will be included in plain English. 

 

 

Themes 

Desktop themes consist of small programs that allow users to personalize their 

wallpaper, icons, and windows and so on to reflect their preferences. Themes 

can reflect a variety of subject matter including certain pop stars, the entire Milky 

Way, landscapes, or an operating system.  

Linux uses a theme manager for changing the look and feel of the desktop. To 

launch the theme manager we click on Kmenu->Control Center->Look and Feel-

>Theme manager. 

Many themes exist at download sites on the Internet. Each version of the desktop 

uses a slightly different implementation scheme. We will show how to identify and 

install news themes. Theme components can be mixed and matched. 

 

 

 

Setting Your System Time 

 Pull up http://www.time.gov in a java enabled browser. The Java is necessary so 

that the website updates itself. 

 Run the date command to set the date to the time on the browser: 

date -s "11/29/2001 13:36:30" 
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to set the time to 13:36:30 on 11/29/2001. Obviously set the command to a 

slightly future time, wait for time.gov to catch up, then press the Enter key. 

 Note that at this point your system clock is accurate. 

 Now it's time to fix your hardware clock. 

 Log in as root 

 /sbin/hwclock -r 

 /sbin/hwclock --adjust 

 /sbin/hwclock --systohc 

 Power down and power back up. Once again check your system time against 

time.gov. It should be good to within a few seconds, and stay that way for awhile 

(days or weeks). 

A little explanation is in order. 

System time runs off interrupts and is extremely accurate. The only problem is 

that it doesn't work unless the operating system is working. For times when the 

computer is down, the hardware clock must keep time. Then, when the computer 

is booted, the hardware clock time is copied to the system time. Naturally, part of 

an orderly shutdown is to copy the system time to the hardware clock.  

/sbin/hwclock -r  

shows you the time according to the hardware clock. It will most likely be wrong.  

/sbin/hwclock --adjust  

makes changes the hardware clock adjustment mechanism so that the hardware 

clock more accurately follows system time.  

/sbin/hwclock --systohc  

sets the hardware clock to the system time.  

Remember, date sets your system time, which is updated by interrupts while the 

operating system is running. hwclock sets your hardware clock, which is a digital 

watch type clock on your motherboard, which runs continuously on battery power 

whether the system is running or not.  
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 Using Gimp to Fill In .pdf Forms 

 

Some .pdf forms allow you to fill them in, but most don't. In the old days your choices 

were a pen or a typewriter -- neither particularly appetizing. Now you can use Gimp to 

fill in the forms.  

What you're going to do is open the .pdf in Gimp, place a transparent layer on top 

of the form, type the information on that transparent layer in the blanks provided, 

and save as a native Gimp document (.xcf).  

Short Instructions 

For those of you who regularly use Gimp and just need a quick reminder of how to do 

this process, here is a short set of instructions:  

1. Open the .pdf in Gimp 

2. Choose 150dpi, heavy text antialiasing, light graphic antialiasing 

3. Each page becomes a separate drawing 

4. Save each page as a .xcf (Gimp native) 

5. Create a new layer called "typewriter", transparent, on top, and save again 

6. Choose the "typewriter" layer. 

7. Use the text tool to fill in the blanks (on the "typewriter" layer) 

8. Edit as necessary, save frequently 

9. Print 

10. Save as xcf, and for posterity save in a ubiquitous format like .jpg. 

Complete Instructions 

Here are the complete step by step instructions:  

1. Open the .pdf in Gimp 

2. Choose 150dpi, heavy text antialiasing, light graphic antialiasing. 

3. Click OK, and notice that each page becomes a separate drawing 

4. Save each page as a .xcf (Gimp native) 

5. For each page, do the rest of the steps... 

6. Right click drawing and choose File/Layers/Layers, Channels & Paths..., and note 

that the "Layers, Channels & Paths" dialog appears, as shown following: 

7. Click the "New Layer" button to bring up the New Layer Options dialog. 

Name the new layer "Typewriter" and make sure the Layer Fill Type is 

"Transparent". The width and height should default to the right quantity. 

8. Click the OK button to return to the "Layers, Channels & Paths" dialog, and note 

that the Typewriter layer appears above the Background layer (if it doesn't, use 

the up and down buttons to fix that): 

9. Click the Typewriter layer line to choose it. This means that editing will be done 

on this layer until you use the "Layers, Channels & Paths" dialog to choose a 

different layer. 
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10. Right click, then File/Save as, and choose a name with the extension .xcf, which 

is the extension for native Gimp files. Make sure the "Determine File Type:"  

choicefield reads "By Extension", and then click OK to save the file. 

At this point you have the equivalent of a layer of clear plastic wrap on top of your form. 

You can write to your hearts content on the wrap, and erase it without erasing the form. 

This means you can move text around at will without changing the form itself.  

To fill in the form, simply use the text tool, on the Typewriter layer, to fill in the 

blanks. Edit as necessary, save frequently. When finished, you can print your .xcf 

file and you get an almost perfect reproduction (it will be a little smaller than the 

original, and I haven't figured out a way to get around that yet).  

As already stated, you  save it as an .xcf file so you can work on it some more, or 

use it as a template for something else later on. However, you might also want to 

save it as a .jpg, because the .xcf format is very unusual, and its possible in 10 or 

20 years Gimp won't exist, but you know there will be tools to retrieve .jpg files.  

 

  Mouse 

The mouse under Linux runs slow, requiring large hand movements to move the pointer. 

Most users adapt to the mouse without notice. I notice the mouse problem primarily when 

using GIMP. I consider myself a fair user of Adobe Photoshop and until I started using 

GIMP, I thought no one could top Adobe’s success story.  

 

My familiarity with GIMP has come along so well, I uninstalled Photoshop from all of 

my computers. I did that right after I discover the frames utility in GIMP. The mouse 

continues to bug me. So, here’s a simple hack to give you a precision mouse experience. 

 

I discovered the problem isn't accelleration. The problem is that the pointer 

moves too few pixels per inch of mouse travel. You should be able to move a 

good 600 pixels per inch of mouse travel, not the ~200 provided by a default 

Linux box. The solution is to add a resolution option to the pointer section of 

/etc/XFConfig86-4 file, as shown below:  

# ************************************************** 

# Pointer section 
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# ************************************************** 

Section "InputDevice" 

 

    Identifier "Mouse1" 

    Driver      "mouse" 

    Option "Protocol"    "imps/2" 

    Option "ZAxisMapping" "4 5" 

    Option "Device"      "/dev/psaux" 

    Option "Emulate3Timeout"    "50" 

    Option "Resolution" "1600" 

 

# ChordMiddle is an option for some 3-button Logitech mice 

 

#    Option "ChordMiddle" 

 

EndSection     

You'll notice I use 1600 for the resolution. That's above the maximum, so it 

produces the maximum resolution. The preceding is for my Logitech optical 

mouse, but the Option "Resolution" "1600" line is appropriate for pretty much any 

mouse, although it's conceivable that for some mice you might want to go higher 

or lower than 1600.  

After making the preceding addition, you must restart X to see the result.  

 

Chapter 21: Secure Connections SSH, FTP, VPN, and Web 
Sharing 

Consider the Operating Systems available for desktop users like Windows, the Mac, Sun 

Solaris, SGI and Linux. Of these, Linux provides the largest suite of Internet utilities by a 

wide margin.   Some people say that the Internet created Linux and Linux created the 

Internet.  Whether true or not, Internet service providers have deployed more Linux 

servers than any other platform. You might expect Linux to lead everyone else in security 

applications. 

Security makes up a critical part of Linux. For the desktop user that means creating 

encrypted pathways from one computer to another. You can also take solace knowing 

that the command line version of an Internet utility more like than not has a graphical 
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equivalent in Linux. Linux developers work at a feverish pace to get a jump on a new 

project. 

Naked Passwords 

When you connect to another computer on the Internet such as ZDNet’s download server, 

you usually do so with no encryption.  The vast majority of traffic on the Internet travels 

in an unencrypted form. When you log into your ISP, you send your user ID and 

password in plain text over a phone line. When you log on to your ISP’s mail servers you 

send your password and ID in plain text over the Internet. 

   

FTP, Logging on to a Remote Computer 

 Remote Connections 

In the early days of the Internet, security did not seem like a problem. Before email, users 

would ftp text files between or among each other. As the World Wide Web became 

popular, an explosion occurred in the business of Internet Service Providers and with 

them came unscrupulous people with the ability to intercept, steal and destroy data.  

 

For downloading software applications, anonymous ftp continues in wide use. Security 

measures can keep crackers from exploiting FTP sites.  

 

Linux has two applications, which can download files from FTP sites and recover in the 

event of a lost connection. Curl and wget work from the command line or console. Curl 

uses a –C option, which allows it to recover a download without having to delete a 

partially completed file and start again. Wget uses a similar option in the command line 

argument, only it uses a lower case –c. 

 

Experienced users recommend curl to download the ISO images.  

 

The command looks like this: 

 

[user@localhost home]$ curl -C - -O 'very_long_url' 

 

ISO URLs tend to have long names because they contain session authentication 

information.  

 

Include the single quotation marks when using curl. The '-C -' option allows you to 

continue the download if it is interrupted. The '-O’ letter option will save the file with 

same name as on the servers. 

 

Wget also works well on ISO files. The command line argument looks like this: 

 

 

[user@localhost home]$ wget -c 'very_long_url' 
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 Remote Access with SSH 

SSH allows users to log into host systems remotely. Unlike rlogin or telnet SSH 

encrypts the login session, making it impossible for intruders to collect clear-text 

passwords.  

SSH is designed to replace older, less secure terminal applications used to log 

into remote systems, such as telnet or rsh. A related program called scp replaces 

older programs designed to copy files between hosts, such as ftp or rcp. 

Because these older applications do not encrypt passwords between the client 

and the server, you should avoid them whenever possible. Using secure 

methods to remotely log into other systems will decrease the security risks for 

both your system and the system you are logging into.  

Reprehensible computer users have a variety of tools at their disposal to disrupt, 

intercept, and re-route network traffic in an effort to gain access to your system. 

In general terms, these threats can be categorized as follows:  

 Interception of communication between two systems — In this scenario, 

the attacker can be somewhere on the network between the 

communicating entities, copying any information passed between them. 

The attacker may intercept and keep the information or alter the 

information and send it on to the intended recipient.  

This can be attack can be mounted through the use of a packet sniffer — 

a common network utility.  

 Impersonation of a particular host — Using this strategy, an attacker's 

system is configured to pose as the intended recipient of a transmission. If 

this strategy works, the user's system will remain unaware it is 

communicating with the wrong host.  
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 Virtual Private Networking and Other Persistent Connections 

Linux provides an improved interface for remotely connecting to another desktop. To 

launch this capability, the user can follow the path Kmenu->Internet->More Internet 

Applications->Remote desktop Connection. The Remote desktop connection runs both 

ways so that a remote user can long on to your desktop if you wish. Remote desktop 

sharing uses Virtual Network Computing known as VNC. 

 

The VNC protocol exists for remote access to graphical user interfaces. The developers 

based their technology on remote framebuffer or RFB.  Users often refer to theVNC 

protocol as the RFB. The protocol allows a server to update the framebuffer displayed on 

a viewer. It works at the framebuffer level and works on most operating systems 

including PDAs.  

Organizations with remote facilities often connect to each other with dedicated 

lines for or over Value Added Networks for EDI. 

The growth of the Internet created an alternative to expensive VANS. The lack of 

security on the Internet created a need for a safe means of transmission. Digital 

Equipment Corporation engineered a concept known as Virtual Private Networks 

(VPNs), which work well over the Internet. 

Virtual Private Networks allow for secured digital communication between two 

parties, which results in a Wide Area Network (WAN).  VPNs transmit over IP or 

datagram (UDP) layers, creating a secure medium through the Internet to an 

intended destination. Most free software VPN implementations incorporate open 

standard, open source encryption to further mask data in transit.  

A free software-based VPN solution exists for Linux called FreeS/Wan that 

utilizes a standardized IPSec implementation. FreeS/Wan solutions act as 

routers between the IP connection from one location to another. When a packet 

is transmitted from a client, it sends it through the router or gateway, which then 

adds header information for routing and authentication called the Authentication 

Header (AH) and trailer information for CRC file integrity and security called the 

Encapsulation Security Payload (ESP).  
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VPNs create difficulty for transmission interceptors or crackers. The outlaw party 

must intercept a packet and decrypt it as well. Intruders who employ a man-in-

the-middle attack between server and client must also have access to the keys 

exchanged for authenticating sessions. VPNs provide a secure and effective 

means to connect multiple remote connections to act as a unified Intranet.  

Linux users and administrators have various options when selecting a software solution to 

secure a WAN. Two methods of implementing VPN and VPN-equivalent connections 

exist with Linux. One solution involves using SSH as a tunnel between two remote 

computers. Telnet and other remote host communication protocols, do not address the 

usability needs of remote users.  

A second solution adheres closely to the formal definition of a VPN.  The application is 

known as Crypto IP Encapsulation (CIPE) and ships with Linux. 

CIPE uses encryption/tunneling on the IP level. In contrast to SSL or SSH tunnels, which 

do tunneling of TCP connections CIPE can also handle UDP, ICMP etc., while the TCP 

solution only applies to TCP-based services.  Also, not all TCP-based services go well 

with tunneling. FTP is an example of a protocol, which is not easy to tunnel. 

In this section, we will configure CIPE. 

 

Summary 

In this proposal we have covered much ground, many topics and approaches. In previous 

projects, I have waited until first drafts, working drafts and final drafts to compose the 

summary. This project shows great promise. Also, this manual has the potential of 

staying popular for a longer time than others.  

I continually monitor trends in the Linux world with a perspective most observers’ lack. I 

see the need to minimize time-to-market by working on a tight schedule. Hopefully this 

can work for both of us. 

Glossary & Index 

The glossary and index will begin with basic topics prior to writing of the first draft. 

During the drafting period, I plan to thoughtfully complete them during drafting and prior 

to the first gallies. 

Appendixes 

 

The Appendixes submitted below will expand. Numerous topics can use coverage and 

this may afford the best area to include those topics. 
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Appendix A: Installing Linux 

This section will discuss different types of installations for a Linux desktop. Later, we 

can choose one or more distributions and present the installation instructions.  

 

How to Download an ISO image and create your own installation.  

Personal Desktop Installations 

Most suitable for new users, the personal desktop installation will install a 

graphical desktop environment (the X Window System) and create a system 

ideal for home or desktop use.  

The workstation installation  

Window System, plus software development tools.  

If you plan to choose all package groups (for example, Office/Productivity 

Applications are a group of packages), as well as select additional individual 

packages, you may want to allow yourself 4 GB or more of disk space. If you 

provide this extra space, you will have room for additional data, if needed.  

Custom Installations 

The custom installation allows you the most flexibility during your installation. The 

workstation and server installations automatically go through the installation 

process for you and omit certain steps. During a custom installation, you have 

complete control over the packages that will be installed on your system. 

The Upgrade Installation 

The installation process for Linux includes the ability to upgrade from prior 

versions of Linux (kernel 2.2 and later). Your upgrade path needs stay within the 

distribution you chose and use. For example, if you chose RedHat then upgrade 

with a later version of RedHat.  
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Upgrading your system installs the Linux modular kernel as well as updated 

versions of the packages, which are currently installed on your system.  

The upgrade process preserves existing configuration files by renaming them. 

You can also find a log of the actions. As software evolves, configuration file 

formats can change, so you may have to re-configure files you customized.  

Linux aficionados recommended that users migrate to the ext3 file system. 

If you choose to migrate to the ext3 file system, take steps so the existing system 

data will not be modified. 

  

Appendix B: Troubleshooting 

 

This appendix provides rich opportunities for content. Currently, I have not found any 

single source of material for troubleshooting the desktop. Information exists in 

newsgroup threads searchable in Google.  Some information exists on project sites.  

My knowledge of the underlying technologies of gnome and KDE will allow me to write 

this section. Also, I find troubleshooting topics in Google newsgroup searches and on 

mailing lists I follow. 

 I plan to provide this information from scratch.  To collect, categorize and answer 

troubleshooting questions, I will deploy faq-o-matic from Sourceforge. This application 

belongs in production not on a website or facing the public. 

I have included some troubleshooting formats which lead me believe that existing Linux 

information does not suit the audience for this manual. A few examples follow:  

 

 Trouble With the Graphical GRUB Screen? 

If, for some reason, you need to disable the graphical 

boot screen, you can do so, as root, by editing the 

/boot/grub/grub.conf file and then rebooting your system.  
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To do this, comment out the line which begins with 

splashimage in the grub.conf file. To comment out a line, 

insert the ; character at the beginning of the line.  

Once you reboot, the grub.conf file will be reread and your 

changes will take place. 

You may re-enable the graphical boot screen by 

uncommenting (or adding) the above line back into the 

grub.conf file and rebooting.  

Booting into a Graphical Environment 

If you have installed the X Window System, but are not 

seeing a graphical desktop environment once you log into 

your Linux system, you can easily start the X Window 

System graphical interface using the command startx. 

Once you enter this command and press [Enter], you will 

be able to log into the graphical desktop of your choice 

(such as GNOME or KDE). 

Problems with Server Installations and X 

If you performed a server installation and you are having 

trouble getting X to start, you may not have installed the 

X Window System during your installation.  

If you want the X Window System, you can perform an 

upgrade to install X. During the upgrade, select the X 

Window System packages, and choose GNOME, KDE, or 

both.  
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Problems When You Try to Log In 

If you did not create a user account during the installation 

you will need to log in as root and use the password you 

assigned to root.  

If you cannot remember your root password, you will 

need to boot your system as linux single. 

If you are using GRUB, once you have loaded the GRUB 

boot screen, type e for edit. You will be presented with a 

list of items in the configuration file for the boot label you 

have selected. 

Choose the line that starts with kernel and type e to edit 

this boot entry. 

At the end of the kernel line, add: 

linux single 

Press [Enter] to exit edit mode. 

Once the GRUB screen has returned, type b to boot into 

single user mode. 

If you are using LILO, press [Ctrl]-[x] to exit the graphical 

LILO screen and gain access to the LILO boot: prompt. 

Next, enter linux single at the LILO boot: prompt. 

Once you have booted into single user mode using either 

GRUB or LILO and have access to the # prompt, you will 

need to type passwd root, which will allow you to enter a 
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new password for root. At this point you can type shutdown 

-r now and the system will reboot with your new password.  

If you cannot remember your user account password, you 

must become root. To become root, type su - and enter 

your root password when prompted. Then, type passwd 

<username>. This allows you to enter a new password for 

the specified user account.  

If you selected either the custom or workstation 

installation and do not see the graphical login screen, 

check your hardware for compatibility issues. The 

Hardware Compatibility List can be found at 

http://www.tldp.org/HOWTO/Hardware-HOWTO/: 

To run the text-based configuration tool, as root, type 

sndconfig in a terminal window.  

sndconfig must be run in runlevel 3. More information 

about runlevels can be found in the. 

If the sound card configuration tools do not help, you may 

need to select the Enable sound server startup option under 

Multimedia->Sound in the GNOME Control Center. 

  

 Appendix C: Where to Go from Here 

 Linux has an abundance of on-line documentation from numerous sources. One of the 

key sites people will recommend resides at http://www.tldp.org/. At that site, the reader 

will find: 

The Linux Documentation Project 

 

HOWTOs: subject-specific help 
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Guides: longer, in-depth books 

FAQs: Frequently Asked Questions  

man pages: help on individual commands  

Linux Gazette: online magazine 

LinuxFocus: multilingual online magazine 

Linux Links directory of Web Resources 

http://www.linuxlinks.com/ 

To give you an idea of the resources collected by the Link Links Site, below you will find 

the topic areas and the number of links. 

Beginners 42 Foreign 145 Publications 77 

Books 563 Hardware 47 Reviews 138 

Community 78 Java 1411 Security 106 

Companies 296 Kernel 509 Software 13669 

Distributions 319 Links 441 Software Ports 10 

Docs 761 Networking 118 Training 123 

Embedded 113 PDA 887 User Groups 1001 

Events 92 Projects 167 Web based software 2518 

 

Other Resources:  [This area will include a bibliography and references] 

Linux Network Administrator's Guide, 2nd Edition 

by Olaf Kirch & Terry Dawson; published by O'Reilly & Associates, Inc. 
 

Distribution Links 

Debian GNU/Linux 

http://www.debian.org/ 
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 Mandrake Linux 
http://www.linux-mandrake.com/ 

 

 Red Hat Linux 

http://www.redhat.com/ 

 

 Slackware Linux 
http://www.slackware.com/ 

 

 SuSE Linux 

http://www.suse.com/ 

 

 

 

  


